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Introduction
Thank You for Purchasing the "L-O3F"

Before using your terminal, or when necessary, read this
manual to ensure safe use and handling.

Before Using this Terminal

L-O3F supports LTE, W-CDMA, GSM/GPRS.

Because this terminal uses radio waves, it may not function in
locations where it is difficult for radio waves to penetrate, such
as tunnels, underground passages, and some buildings in
areas where radio wave signals are weak or out of the Xi/FOMA
service area. Even when you are on a higher floor of a tall
building or condominium and nothing blocks your view outside,
this terminal may not be able to receive or transmit signals.
Also communication may be interrupted even when the
Antenna Indication Lamp on this terminal lights indicating a
strong signal reception with 3 antenna indication bar.

This terminal communicates via radio waves by converting
voices into digital signals. If you move into an area where signal
reception is poor, the digital signals may not be accurately
decoded and what you hear may differ slightly from what was
actually said.

DOCOMO is not responsible for any economic losses incurred
through lost communication opportunities caused by external
factors such as malfunction or electrical outage.

This terminal can be operated in Xi area, FOMA Plus-Areas and
FOMA HIGH-SPEED Areas.

This terminal does not support i-mode functions (i-mode mail,
connection to i-mode sites (program) or i-appli, etc.).

SIM unlock

This terminal supports SIM unlock. If you release SIM lock,

you can use SIM by a carrier other than NTT DOCOMO.

- The SIM unlock service is provided at a docomo Shop.

« A SIM unlock charge is separately required.

« Note that it takes several days for SIM unlock.

« If you use a SIM other than by DOCOMO, LTE system is
unavailable. And available services and functions will be limited.
DOCOMO is not liable to any failures or malfunctions.

« For details of SIM unlock, refer to NTT DOCOMO website.

The latest information of this manual can be downloaded from
the DOCOMO website.

H The URL of PDF for INSTRUCTION MANUAL
http://www.nttdocomo.co.jp/english/support/trouble/
manual/download/index.html

% The URL and the information contained in the manual are
subject to change without prior notice.



Basic Package

M L-O3F Terminal (With Back cover L30, Warranty)

l L-O3F INSTRUCTION MANUAL for Connection Guide

M USB Extension Cable (Sample)




How to Read this Manual

Contents

L-O3F Manual is composed of "L-O3F INSTRUCTION MANUAL for Connection Guide" and "L-O3F INSTRUCTION MANUAL"
(this manual).

Hl "L-O3F INSTRUCTION MANUAL for Connection Guide"
The following contents such as connection to computer, troubleshooting, specifications of L-O3F are described.
- Contents/Precautions
» Before Using this Terminal
« Setting Up
« Appendix/Troubleshooting

Hl "L-O3F INSTRUCTION MANUAL" (this manual)
Besides the above contents described in "L-O3F INSTRUCTION MANUAL for Connection Guide", the contents of

configuring communication through special application are also written.
This manual is supplied with PDF. To view this manual, Adobe Reader (Version 6.0 or later is recommended) is necessary.

« L-O3F Connection Manager
Mobile Broadband
Configuring Network Manually
Overseas Use

« Please understand that in "L-O3F INSTRUCTION MANUAL", "this terminal" refers to "L-O3F".
Note that in "L-O3F INSTRUCTION MANUAL", "PC" refers to both "Windows PC" and "Mac".
Operation procedures and images may differ depending on environment.

Reprinting all or parts of this manual is prohibited.

Information contained in this manual is subject to change without prior notice.
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Features of the L-O3F
"Xi" is a service of DOCOMO supported by LTE (Long Term Evolution) which is the international communication standard.
FOMA (Freedom Of Mobile multimedia Access) is the name of a service provided by DOCOMO based on the W-CDMA
system, which is certified as one of the global standards of 3rd generation mobile communication systems (IMT-2000).

l Supported Xi data communication

The terminal supports data communication at a speed

of up to 75Mbps for downloading and up to 25Mbps for

sending.

¥ Within a part of the Xi area.

« Refer to DOCOMO website for detailed supporting areas.
Communication speed is theoretical values when sending
and receiving data which does not show the actual ones.
The actual communication speed depends on
communication environment and network congestion.

- The FOMA area which is out of Xi area is also available.

M International Roaming Service

Data communications from a PC are available through

using 3G network or GPRS network in foreign

countries. »P90

¥  "WORLD WING" is usually applied along with the
contract of this terminal. Please contact a docomo
shop or a docomo Information Center to confirm the
details.

M Correspondence with the FOMA HIGH-SPEED Area
You can enjoy high speed communication (Best effort
system) at a maximum of 14Mbps for receiving and
5.7Mbps for sending.

« Communication speed is theoretical values when sending
and receiving data which does not show the actual ones.
The actual communication speed depends on
communication environment and network congestion.
For details of areas supporting a maximum of 5.7Mbps
for sending, view DOCOMO website.

Sending and receiving data may become 384kbps even

in the FOMA HIGH-SPEED area.

Sending and receiving data become 384kbps in FOMA

area out of FOMA HIGH-SPEED area.

.
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Safety Precautions (ALWAYS
FOLLOW THESE PRECAUTIONS)

H Before using this terminal, read these "Safety
Precautions” carefully so that you can use it properly.
After reading the safety precautions, keep this manual in
a safe place for later reference.

M These precautions are intended to protect you and
others around you. Read and follow them carefully to
avoid injury, damage to the product or damage to
property.

M The signs below indicate the levels of danger or damage
that may occur if the particular precautions are not
observed.

This sign indicates that
incorrect handling has a
high possibility of
causing death or serious
injury.

This sign indicates that
incorrect handling poses
arisk of causing death or
serious injury.

This sign indicates that
incorrect handling poses
a risk of causing slight
injury or damage to the
product or property.

A DANGER

A WARNING

A CAUTION

M The following symbols indicate special warnings
regarding product usage.

Denotes things not to do (prohibition).

Don’t
® Denotes not to disassemble.
Nty
g'q Denotes not to use where it could get

= wet.
Not fiquids

Denotes mandatory instructions
(matters that must be complied with).

@

Do

M "Safety Precautions" are explained in the following
4 sections.

General Precautions for this Terminal and UIM 6
Precautions for this Termingl - c--xcocereerererermaes e 7
Precautions for the UIM e, 9
Notes on Using near Electronic Medical Equipment -+« 9
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General Precautions for this Terminal

and UIM

A DANGER

Do not use, store or leave the terminal in

hot places (e.g. by the fire, near a heater,
under a kotatsu, in direct sunlight, in a car
in the hot sun).

Fire, burns, or injury may result.

Don’t

Do not put this terminal or UIM in heating
appliances such as microwaves or high
pressure containers.

Fire, burns, injury, or electric shock may
result.

Don’t

®

Notdeassey

Do not disassemble or remodel this
terminal and its accessories.

Fire, burns, injury, or electric shock may
result.

TN Do not get this terminal and its

N accessories wet with water, drinking
water, pet urine, etc.

Fire, burns, injury, or electric shock may
result.

Not liquids

Contents/Precautions

A WARNING

Do not subject this terminal and its
accessories to strong force, severe
shocks, or throw them.

Fire, burns, injury, or electric shock may
result.

Keep conductive foreign objects (metal,
pencil lead, etc.) away from the USB
connector. Do not insert such objects
inside this terminal.

Fire, burns, injury, or electric shock may
result.

Don’t

Do not cover or wrap this terminal or its
accessories with bedding, etc. while using.

Don’t Fire or burns may result.

Make sure to turn off the computer which
is connected with this terminal before you
go near a flammable gas such as gasoline
fumes.

Catching fire may result.




A _CAUTION =
A WARNING

Do not place this terminal or UIM on
unstable locations such as wobbly tables
or slanted locations.

Don’t ; ) L
This terminal or UIM may fall, resulting in
injury.

Do not store this terminal or UIM in humid
or dusty places, or in hot areas.

Don’t Fire. burns, or electric shock may result.

If children use this terminal or UIM, a
guardian should explain the precautions
Do and correct operations. The guardian

should also make sure that the
instructions are followed during use.
Injury may result.

Keep out of reach of babies and infants.
Accidental swallowing or injury may result.

Don’t

Do not get liquids such as water or foreign
objects such as metal pieces or
flammable materials into the UIM slot of
this terminal.

Fire, burns, injury, or electric shock may
result.

M

Do

Turn off this terminal in places where use
is prohibited such as airplanes or
hospitals.

Electronic devices or electronic medical
devices may be adversely affected. Follow
the instructions when using inside medical
facilities.

If you wear any implanted electronic
medical devices, contact the
manufacturer or dealer of the electronic
medical device to ask about the effect
from radio waves.

Electronic medical devices may be
adversely affected.

Contents/Precautions
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Remove this terminal from USB port in
— places near high-precision electronic A CAUTION

Do devices or devices using weak electronic

signals. Do not use the broken terminal.
Electronic devices may be adversely Fire, burns, injury, or electric shock may
affected by reasons such as malfunction. Don't result

% Electronic devices that may be affected
Hearing aids, implanted cardiac pacemakers,

implanted defibrillators, other medical 0 If you use this terminal in a car, contact

electronic devices, fire alarms, automatic f
doors and other automatically controlled the car manufacturer or dealer to ask

f:fievices. ing an implanted card Do about the effect from radio waves.
you are using an implianted caraliac pace : f
maker, implanted defibrillator or any other Dependmg on _the type of a car, in-car
electrfomc medical de,lwce,f Cﬁnsdult.thef electronic devices could be adversely
manufacturer or retailer of the device for i i i
advice regarding possible effects from radio affeo_ted._ In thls. case, stop using this
waves. terminal immediately.

depending on your physical conditions or
Do predisposition. If an abnormality occurs,

stop using this terminal immediately, and

then seek medical attention.

For the material of each part =P10

"Material List"

0 Itching, rash or eczema may be caused

the parts when you close or open this
Do terminal.
Injury or other accidents may result.

0 Be careful not to get your finger caught in

8 Contents/Precautions




A WARNING =

Be sure to adhere to the following

A CAUTION 0 regulations inside medical facilities.
@®Keep this terminal out of operating

(o]
Be careful not to touch the edge of UIM rooms, intensive care units (ICUs) or
when removing it. coronary care units (CCUs).
Do 'niury may result. @Turn off the PC in hospital wards.

@ Turn off the PC in hospital lobbies and
corridors if electrical medical devices
could be nearby.

NOt.eS on Using near Electronic Medical @If the medical facility has specific zones
Equipment where use or possession of mobile
W The description below meets "Guideline on the terminals is prohibited, follow those
regulations.

Use of Radio-communication Equipment such as
Cellular Telephones - Safeguards for Electronic

Medical Equipment” by the Electromagnetic Turn off the PC in crowded trains or other
Compatibility Conference. 0 public places where implanted cardiac
pacemaker or defibrillator wearers could
Do
be nearby.
Operation of an implanted cardiac
pacemaker or implanted defibrillator may
be adversely affected by radio waves.

Contents/Precautions 9



0 If you use medical equipment such as an
tofbrilator 158 $he manis termine) 2oom
- Do defibrillator, use the mobile terminal 22cm Material List

or more away from the implanted cardiac Material/Surt
pacemaker or implanted defibrillator. Part att?_‘rel:tm:ntace
Operation of medical equipment may be

adversely affected by radio waves. Exterior case (Front part) s

Exterior case (Back part : Back cover) | PC

. . . . Frame PC+GF30%
Patients using electronic medical — >
equipment other than implanted cardiac Communication Status Lamp Transparent PC
Do pacemakers or implanted defibrillators USB Connector/Bracket PC
(using outside medical facilities for USB Connector sUS

treatment at home, etc.) should check the
influence of radio waves upon the
equipment by consulting the
manufacturer.

Operations of electronic medical
equipment may be adversely affected by
radio waves.
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|Hand|ing and Care |

General Usage Guidelines

B Keep this terminal away from water.
This terminal and UIM are not waterproof. Do not
use the terminal in places with high humidity such
as a bath or where rain may get it wet. If you carry
the card close to your body, moisture from sweat
may corrode the internal parts causing a
malfunction. Note that malfunctions deemed to
be caused by water are not covered by the
warranty, and may be impossible to repair. Since
these malfunctions are not under warranty, even
when repair is possible, it will be done at the
user's expense.

M Clean this terminal with a dry, soft cloth (Lens
cleaning cloth).
If this terminal is wiped with alcohol, paint thinner,
benzine or detergent, the printing may disappear
or color may fade.

B Keep the connector contacts clean with a dry
cotton swab.
Clean the connector contacts with a dry cotton swab
to prevent contacts from getting dirty which can
result in intermittent connections. Be careful when
cleaning the connector contacts.

MWDo not place the equipment near air conditioner
outlets.
Condensation may form due to rapid changes in
temperature, and this may corrode internal parts
and cause malfunction.

HMDo not place this terminal where excessive force
will be applied to it.
If this terminal is inserted to a full bag, or placed
in a pocket and sat on, its internal PCBs may be
damaged or malfunction. Such damage is not
covered by warranty.

M Read the individual manual attached to this
terminal.

This Terminal

B Avoid using in extremely high or low temperatures.
This terminal should be used within a temperature
range from 5 °C to 35 °C and a humidity range
from 45 % to 85 %.

HEThis terminal may adversely affect fixed phones,
televisions or radios in use nearby. Use as far as
possible from such appliances.

B Keep a separate record of any information stored
on this terminal and store the copies in a safe
location.

DOCOMO assumes no responsibility for the loss
of any of your data.

B Do not drop this terminal or subject it to shocks.
Damage or malfunction may result.

Contents/Precautions '|'|




M Do not insert a USB connector to PC crookedly
or do not pull it when it is inserted.
Damage or malfunction may result.

B Remove this terminal from the PC when
transporting.
Malfunction or damage may result.

Mt is normal for this terminal to become warm
during use. You can continue to use it even when
it is warm.

UM

B Do not put excessive force on the UIM when
inserting or removing it into this terminal.

HNote that DOCOMO assumes no responsibility for
malfunctions occurring as the result of inserting
and using UIM with another IC card reader/writer.

B Always keep the IC portion of the UIM clean.

B Clean the UIM with a soft, dry cloth (Lens
cleaning cloth).

M Be sure to keep a separate note of the
information registered to this terminal.
DOCOMO assumes no responsibility for the loss
of any of your data.

M Visit docomo Shop to return the UIM for the
environmental purpose.

B Do not scratch, touch carelessly or short circuit
the IC portion.
Data loss or malfunction may result.

'|2 Contents/Precautions

MWDo not drop or give shock to the UIM .
Malfunction may result.

H Do not bend or put heavy things on the UIM.
Malfunction may result.

Bl Do not insert UIM into this terminal with labels or
stickers attached on.
Malfunction may result.

CAUTION

M Do not use the modified this terminal. Using
modified this terminal result in violating the law of
Electromagnetic Compatibility.

This terminal has been complied with technical
standard of wireless equipment stipulated by law
of Electromagnetic Compatibility. As a proof,
"Technical standard compliance mark & " is
indicated in the inscription seal. If this terminal is
modified by turning the screw to the left to
disassemble, technical standard compliance
becomes invalid.

Please do not use this terminal during the time
when technical standard compliance is being
invalid, since you are in violation of the law of
Electromagnetic Compatibility.

HDo not alter the basic software.
Repairs may be refused as a maodification of
software.

B Keep this terminal 15mm or more away from your
body while communicating.
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Names of Parts and Functions

a USB Connector
A connection terminal used to connect

I with PC

b Communication Status Lamp—
P15

Indicates status of this terminal

¢ Xi antenna Part
The antenna is built in this terminal.

d Back cover
Cover to protect UIM attaching part

Pulling out a:
Example 1: Example 2:
% Use the USB connector pulling out up to 180 % The tip of the USB connector can be rotated up to 180 degrees
degrees (90+90 degrees) from the terminal. (90+90 degrees). Note that it can be rotated in the same
Note that trying to pull out over 180 degrees direction. Rotating in the opposite direction or over 180 degrees
may cause damage. by force may cause damage.

'|4 Before Using this Terminal




Mode Indication Lamp Using UIM

A UIM is an IC card that stores personal information such as
your phone number. Without the UIM installed in this terminal,
you cannot use data communication. For detailed information,
refer to UIM Manual.

You can use the terminal only with UIM. Exchange your
docomo mini UIM card or FOMA card at a docomo Shop.

Communication
Status Lamp

Inserting/Removing
Status Status Lamp

W-CDMA (36) Green Insert a UIM holding the terminal with both hands.

HSDPA Magenta . . . .
While ) HSUPA Magenta F‘r.ess the_ bacl_< cover in the dlr.ectlo.n ato slide
communicatin

€ GPRs Gvan |t_ in the direction b. Then pull it up in the
X direction c to remove

During packet

communication (no White

data sent or received)*
Out of service Yellow

PINT lock ON Red Back cover
PINT Waiting to unlock

PINT Red

% A long period with no sent or received data.

Before Using this Terminal ]5




2 Insert a UIM under the card slot in the = .

direction of arrow with the IC chip side down
Remove a UIM holding the terminal with both hands.

Press the back cover in the direction a to slide
IC it in the direction b. Then pull it up in the

| direction c to remove

Notch

UIM slot guide
Back cover

UM

Fit the back cover to the ditch of this terminal
at approximately 1mm. While pushing in the

direction of a, slide the back cover in the 2 Slide the UIM in the direction of arrow to
direction of b until it clicks remove
UM
Approx.
Tmm

'|6 Before Using this Terminal



3 Fit the back cover to the ditch of this terminal
at approximately 1mm. While pushing in the
direction of a, slide the back cover in the
direction of b until it clicks

Approx.
Tmm

Note

« Do not lose the removed UIM.
« Make sure to both sides of the UIM.

EQ

Be careful not to scratch the UIM IC tip.

Inserting a UIM in the reversed direction may cause
malfunction.

Inserting or removing the UIM with an excessive force may
cause damage to your UIM.

Do not remove the UIM while this terminal is inserted to a
PC, it may cause damage to your UIM.

Do not transfer the UIM to others.

Do not get the UIM scratched or transformed. The data
stored in UIM will disappear or be changed.

You can set PIN1 code (Personal Identification Number)
for UIM. The default setting for the PIN1 code is [0000].
The PIN1 code is a 4 to 8-digit security code to be entered
every time this terminal is turned on for user verification to
prevent any unauthorized use by others.

If your UIM is set to require a PIN1 code, data
communication cannot be performed until the PIN1
code is entered. Use UIM after verifying the PIN1 code,
or set (—P57) UIM not to verify the PIN1 code in
advance.

Hl Changing PIN1 Code
You can change the PIN1 code to any number. To
prevent unauthorized use by third parties, change it to
your own number. If you improperly enter the PINT code 3
times in a row, PIN1 code is locked automatically (PIN
Lock), so be sure to keep a separate note of the numbers
you set.
« "Changing PIN1 Code" (—+P57)

M Unblocking PIN Code
The unblocking PIN code is the number in 8 digits used
to unblock the PINT code, which cannot be changed by
yourself. If you improperly enter the unblocking PIN code
for 10 times in a row, the UIM is locked automatically.

Before Using this Terminal
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Caution

- Do not set PINT code to numbers that can easily make a
guess, such as "birth date", "part of your phone number”,
"numbers from address or room number”, "1111""1234",
etc. Also memo your PIN1 code and keep it well.

Keep your PINT code away from being known by other
people. DOCOMO assumes no responsibility for the loss of
any of your data results from abuse of PIN1 code.

If you forgot your PIN1 code, you (if you are the
covenanter) are required to bring your ID (driving license,
etc.) and UIM to a docomo shop.

For details, please contact "docomo Information Center" on
the back cover of this manual.

Unblocking PIN code is written on the proposal form
handed in at time of contract in docomo shop. For
covenanter who signed the contract other than docomo
shop are required to bring your ID (driving license, etc.) and
UIM to a docomo shop, or contact "docomo Information
Center" on the back cover of this manual.

'|8 Before Using this Terminal

Activate L-O3F Connection Manager
PINT code Verification screen appears

Enter PINT Code
Incorrect entry 3 times in a row

Enter Unblocking PIN Code
oK Incorrect entry 10 times in a row

Available to set a new

PINT code Contact a docomo Shop



Available Communications

Xi Data Communication/FOMA Packet

Communication

Fees for this communication method are based on the
amount of exchanged data. You can perform data
communication at a speed of up to 75Mbps for receiving
data and up to 25Mbps for sending data by using a
connection that allows Xi data communication or FOMA
packet communication such as "mopera U", one of
DOCOMQO's Internet connection services.

% Communication speed is theoretical values when sending
and receiving data which does not show the actual ones.
The actual communication speed depends on
communication environment and network congestion.

« Depending on bandwidth, communication speed for receiving is
theoretically 100/100/75/37.5Mbps (with bandwidth of [20/
15/10/5MHz]), and for sending is 50/37.5/25/12.5Mbps
(with bandwidth of [20/15/10/5MHz]).

« For the FOMA HIGH-SPEED areas outside Xi area, the
maximum speed for receiving data is 14Mbps and for sending
is 5.7Mbps (best effort).

« Sending and receiving data become 384kbps in FOMA area
out of Xi area and FOMA HIGH-SPEED area.

« The communication speed varies depending on the access
point and radio wave status.

« The communication speed varies depending on the overseas
carrier or network when using overseas.

Note

« Communication fees become high when performing
communications with large amount of data such as
browsing websites with many graphics or downloading
data.

Data communication may take more time or become
difficult to connect depending on the network congestion.
For customers who use a large amount of data
communication (Approximate 1Gbytes data or more is
used within the last three days including the current day),
it may have difficulties in sending and receiving data on
time. Also, data communication may get disconnected in
the following cases such as when a large amount of data
communication occurs at a time or within a certain period
of time, when being connected for a long time, or when
connecting several times in a row within a certain period of
time.

» This terminal does not support 64K data communication.
« This terminal does not support Remote Wakeup.

« This terminal does not support FAX communication.

Before Using this Terminal
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Usage Notes

M Internet service provider (ISP) fees

Connecting this Terminal to a PC

Fees to an ISP may be required to connect to the
Internet. These fees are added to the Xi service fees and
are paid to your ISP directly. For details on connection
fees, contact your ISP.

You can subscribe to such as 'mopera U", one of
DOCOMQO's Internet connection services. Charge for
subscribing "mopera U" is required.

For service and connection settings of "mopera U", visit
the "mopera U" website.

http://www.mopera.net/ (Japanese only)

M User authentication to access networks

Depending on the access point, user authentication (ID
and password) may be required to connect. If required,
enter the ID and password from communication software
or dial-up network. The ID and password will be provided
by the network administrator of your ISP or the access
point. For details, contact your ISP or network
administrator.

Hl Requirements for communication

The following conditions must be met to perform

communications using this terminal. However, a

connection may not be established if traffic is heavy at

the base station or if radio signals are weak.

« This terminal must be in Xi network, FOMA network or
DOCOMOQ's roaming service area.

« The access point corresponds to the Xi data
communication or FOMA packet communication.

20 Before Using this Terminal

When connecting this terminal with a PC for the first time,
it is required to install L-O3F Connection Manager
(including a driver). For installing L-O3F Connection
Manager, refer to the following.

« For Windows: "Preparation before using L-O3F" (—=P32)
« For Mac: "Preparation before using L-O3F" (=P41)

Cheerting e

'I Turn on a PC

2 Connect this terminal with the PC

B When using the USB extension cable (Sample)

a Put your fingertip on the lug of the USB connector to
pull out 180 degrees

Lug



b Hold the connector part of the USB extension cable and ¢ Hold the connector part of the USB cable and insert it
insert into the USB connector of this terminal in into PC's USB port in direction of arrow with inscription
direction of arrow of the USB side up
* Firmly insert into the USB connector.

Inscription of USB

USB connector

USB port USB extension cable

USB extension
cable

Before Using this Terminal 2]
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Bl When connecting with a PC directly
« The tip of the USB connector on the terminal can be
rotated 90 degrees according to the orientation of your PC.

a Put your fingertip on the lug of the USB connector to
pull out 90 degrees

Lug

USB Connector

b Rotate the tip of the USB connector 90 degrees with
the engraved side up

usB
Connector

% The connector can be rotated 90 degrees more (up to
a total of 180 degrees). Note that trying to rotate over
180 degrees by force may cause damage.

Before Using this Terminal

¢ Insert the USB connector of this terminal into the PC's
USB port

USB port
USB Connector

 In Step b, you can insert the USB connector as is without
rotating 90 degrees to use.

USB port

% Do not rotate the USB connector inserted to the PC's
USB port. Malfunction or damage may result when
subject this terminal to severe force or shocks due to
carelessness.



3 Start communication connection
» Using "L-O3F Connection Manager" (—=P49) Removing

» Using "Mobile Broadband" (—+P63)

« Configuring manually (—P69) 'I Disconnect data communication
If the L-O3F Connection Manager is running, or L-O3F APN
Note Tool is running, close it first. Make sure the data connection

is disconnected.

Remove this terminal

M When using the USB extension cable (Sample)
a Hold the connector part of the USB extension cable and
pull out this terminal from PC's USB port in direction of
arrow

Communication

Status Lamp
Check that the color of Communication Status Lamp is
blue, magenta, cyan or green.
Keep the PC away from entering conditions such as sleep
(standby) or power off. Operations may become abnormal.
In that case, remove this terminal first before the PC turns
to sleep (standby) or power off.

USB port USB extension cable

Before Using this Terminal 23
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b Hold the connector part of the USB extension cable and
pull out from the USB connector in direction of arrow

USB connector

USB extension
cable

Before Using this Terminal

¢ Place the USB connector into this terminal

Lug

USB Connector

% Place the USB connector with the lug shown at the
front.

W When connecting to a PC directly
a Hold the USB connector part of this terminal and pull
out this terminal straight from PC's USB port

USB port
USB connector



b Rotate the tip of the USB connector 90 degrees as
shown

usB
Connector

¢ Place the USB connector into this terminal

USB Connector

Caution

If you force to remove this terminal or try to pull out the
USB connector, malfunction may result.

Removing this terminal from the PC during data
communication may suspend data communication and
result malfunction or data loss.

Before Using this Terminal
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Setting Up

Hl Data communication via L-O3F
"Communication configuration file (Driver)" is required to install on a PC to recognize this terminal.
In L-O3F Setup, not only "Communication configuration file (Driver)", the data communication software of "L-O3F
Connection Manager" and "L-O3F APN Tool" (Windows only) will be installed as well.
Data communication is available with only L-O3F Connection Manager, if necessary using Mobile Broadband (Windows 7
only) is also available.

- For PC with Windows OS in it, data communication is also available based on configuring manually after installing L-O3F

Connection Manager.

M Installation of L-O3F Connection Manager
Since L-O3F has "Zero installation”, when connecting this terminal to a PC for the first time, "L-O3F Connection Manager"
installation screen appears automatically. "Zero installation" is supported by PC with Windows OS in it.
Mac does not support "Zero installation’, clicking the CD-ROM icon displayed when connecting this terminal to a PC
continues installation.

The procedure of setting up is described on the next page.
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Work Flow of Setting Up

Connecting this terminal with a PC
+ Windows Version»P32
+ Mac Version»P41

Installing L-O3F Connection Manager, Communication configuration file (Driver),
L-O3F APN Tool (Windows only) (Standard installation/Custom installation)

Confirmation after Setup
« Windows Version»P36/ + Mac Version»P45

Using L-O3F
Connection
Manager

Configuring L-O3F Connection
Managerp»P54

Using Mobile
Broadband of
Windows 7

Without using
L-O3F Connection
Manager

Configuring Communication manually
+ Windows Version »P70

Communication connection
via L-O3F Connection
Manager»P50

Communication connection
through Mobile Broadband
»PB5

Communication connection manually via OS
- Windows Version»P86
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Operating Environments

Using this terminal under the following operational
environments.

Item Requirement

PC Main « PC/AT compatible and Mac.

Unit USB port (standard of Universal Serial Bus
Specification Rev2.0)

Do not operate via USB hub (including USB port

- on monitor and keyboard).

Display resolution of 800X 600 pixels, 16-bit
Color (65,536) or higher is recommended.

0s*1 Windows XP SP3 (Japanese/English version)
Windows Vista SP2 (Japanese/English version)
Windows 7 SP1 (Japanese/English version)
Mac OS X 10.6.8/10.7.2 (Japanese/English
version)*2

Required Windows XP: 256Mbytes or more
Memory*3 | Windows Vista: 512Mbytes or more
Windows 7: 1Gbytes or more(32bit), 2Gbytes or
more (64bit)
Mac OS X 10.6.8: 1Gbytes or more
Mac 0S X 10.7.2: 2Gbytes or more

Hard Disk

Space’d 50Mbytes or more available space

% 1 Operations on upgraded OS or added/modified
environment are not guaranteed.

%2 Only Mac with CPU made by Intel Corporation is available.

%3 Required memory or available hard disk space may vary
depending on the system environment of a PC.
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For latest information of operation environment, visit NTT
DOCOMO website.

Note

« The software may not work depending on your operating
system environment and type of machine. DOCOMO does
not guarantee any operation other than the operation
environment described in the table on the left side.



Windows Version

Installation of L-O3F Connection Manager is only required

when connecting this terminal to your PC for the first time.

% The following procedures or screen images are all based on
the example of Windows 7.

Note

When installing, insert this terminal into USB port after OS
is activated.

Do not remove this terminal while installing.

Installation may take several minutes depending on the PC.
Do not install or uninstall during data communication.

End all the applications before installing. Also end
programs on Windows including virus check software.
When installing, make sure to install from the account with
PC supervisor privileges. An error will occur during
installation if you install from the account without privileges.
For details on setting up PC supervisor privileges, contact
your computer manufacturer or Microsoft Corporation.
When connecting this terminal to a PC for the first time,
you are required to enter PIN1 code to use UIM. -P58

M If CD/DVD playback and written software is installed
into a PC
Depending on the CD/DVD playback or writing application
installed in a PC, this terminal may not be recognized
normally even if the terminal is connected while the
application software residents* or is activated.
Refer to "Troubleshooting" for proper solutions. =P113
#Including the case in which its icon stays on the taskbar.
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Preparation before Using L-O3F

Setting Zero Installation (Auto)

Turn on a PC and activate 0OS

Connect this terminal with the PC

The device driver which connects this terminal to a PC is
automatically installed by zero installation. When the

Nd

- installation finishes, the message, "Device driver software

installed successfully." appears, then L-O3F Connection
Manager setup screen appears.

"AutoPlay" screen will be displayed depending on settings of

the PC. If the screen is displayed, check "Always do this for
software and games:" and select "Run LO3FLauncher.exe".
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Click [Yes] on "User Account Control" screen

H For Windows Vista
« (Click [Continue] on "User Account Control" screen.

M For Windows XP
» "User Account Control" screen is not displayed. Follow
the next step.
Select "English (United States)" in the
"Choose Setup Language" screen, then click
[Next]



5 Click [Next]

Confirm the contents of "License Agreement".

When agree with the contents, select "I
accept the terms of the license agreement”
and click [Next]

7 Select "Standard installation (recommended)”
on the "Select the installation method"
screen, then click [Next]

Installation starts. Then installation of L-O3F communication

configuration file (Driver) continues.

% It may take time to move to the next procedure depending
on your PC.

M Custom installation
a On the "Select the installation method" screen, select
"Custom installation" and click [Next]
b Select "Install all of L-O3F Connection Manager, L-O3F
APN Tool, and L-O3F USB Driver. (Recommended)" or
"Install L-O3F USB driver only", then click [Next]

Setting Up



8 Confirm that this terminal is recognized by
the PC

On the right side of the taskbar, "Installing device driver

software" appears, and this terminal is recognized

automatically.

¥ To recognize this terminal automatically, "L-O3F is not
recognized" may appear on L-O3F Connection Manager
temporarily. After a while, this terminal will be recognized.

- If this terminal is recognized properly, "Your device is ready to

use" will appear.

« To install all, also set "Profile setting" » "Automatic
connection setting".

« If you install L-O3F USB driver only and make packet
communications, connect in the manner in Mobile

A M For Windows Vista
Broadband (—P85) or Configuring Network Manually . On the right side of the taskbar, a message of
(—P69). )

"Installing device driver software" appears, this terminal

« For Windows XP, the "Setting optimized will be recognized automatically.

communication" screen appears. When the setting is
made, click [Next] to proceed the next step.

« If this terminal is recognized normally, a message of
"Your devices are ready to use" will appear.
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M For Windows XP M Installing Flash Player
« On the right side of the taskbar, "Found New Hardware" If Flash Player is installed into your PC, screen shown in
appears, and this terminal is recognized automatically. "Confirming L-O3F Connection Manager" (—P36) appears
and setup finishes.
If not, a message appears. Install Flash Player by the
following procedures.
a Click [OK]
« If this terminal is recognized properly, "Your new
hardware is installed and ready to use." will appear.

9 Click [Finish]
b Read the content of "License Agreement”, check "I
have read and agree to the terms of the Flash Player
License Agreement.” and click [INSTALL]

- If you optimize communication settings (W-TCP setting)
under Windows XP, click [Finish] on the setup wizard
screen to restart.
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¢ Click [DONE]

Confirming after Installation

Confirming L-O3F Connection Manager

Double click L-O3F Connection Manager icon
®» (blue) displayed on the desktop

When the following screen is displayed, the confirmation of
installation finishes.

Installation finishes.

Note

« Alternatively, remove this terminal from the PC, and then
reconnect to check.

» For Windows 7, L-O3F Connection Manager cannot be
activated due to the setting of mobile broadband auto
connection. Set to "Never connect automatically". =P65
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Confirming the Installed L-O3F Communication

Configuration File (Drivers)

Confirm whether L-O3F Communication Configuration File
(Drivers) is set in a PC.

'I Click @ (Start) » "Control Panel" » "System
and Security"

M For Windows Vista
« Click @ (Start) » "Control Panel’ » "System and
Maintenance".
H For Windows XP
« Click [start] » "Control Panel" » "Performance and
Maintenance" » "System".

2 Click "Device Manager"

M For Windows Vista
« Click "Device Manager" » [Continue].
M For Windows XP
« Click "Hardware" tab » [Device Manager].

3 Click each device display to confirm the driver
name installed

- Confirm whether the driver name is displayed below
"Network adapters", "Ports (COM & LPT)", "Modems",
"Universal Serial Bus controllers”.

Setting Up
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« COM port number differs depending on user and PC.

0os

Windows
7

Windows
Vista
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Device name

Network adapters

Ports (COM & LPT)

Modems
Universal Serial
Bus controllers

Network adapters

Ports (COM & LPT)

Modems

Universal Serial
Bus controllers

Driver name

docomo LO3F USB NDIS
Driver

docomo LO3F NMEA
Serial Port

docomo LO3F USB Serial
Port

docomo LO3F Modem
Driver

USB Composite Device

docomo LO3F USB NDIS
Driver

docomo LO3F NMEA
Serial Port

docomo LO3F USB Serial
Port

docomo LO3F Modem
Driver

USB Composite Device

Driver name

Windows | Network adapters | docomo LO3F USB NDIS
XP Driver

Ports (COM & LPT) | docomo LO3F NMEA
Serial Port
docomo LO3F USB Serial
Port

docomo LO3F Modem
Driver

0os Device name

Modems

Universal Serial
Bus controllers

USB Composite Device

Note

- After inserting this terminal into the PC USB port, if this
terminal is not recognized, try with another USB port.
Depending on PC, this terminal may not be recognized with
certain USB port.

When communicating data with L-O3F Connection
Manager, configuring with L-O3F Connection Manager is
required.—P54

When using mobile broadband of Windows 7 to
communicate data, set in mobile broadband. =P85
When communicating data with neither L-O3F Connection
Manager nor Mobile broadband of Windows 7, configure it
manually.—P70



Uninstalling L-O3F Connection Manager

(including a driver)

Before uninstalling, remove this terminal from the PC.

When uninstalling, make sure to install from the account with
PC supervisor privileges.

Click € (Start) » "All Programs" » "L-O3F
Connection Manager" » "Uninstall L-O3F
Connection Manager"

H For Windows Vista
« Click @ (Start) » "All Programs" » "L-O3F Connection
Manager" » "Uninstall L-O3F Connection Manager".
M For Windows XP
« Click [start] » "All Programs" » "L-O3F Connection
Manager" » "Uninstall L-O3F Connection Manager".

2 Click [Yes] on "User Account Control" screen

Click [No] to stop uninstalling.
M For Windows Vista
« Click [Continue] on "User Account Control" screen.

H For Windows XP
« "User Account Control" screen is not displayed, follow
the next procedure.

Click [Yes] on the confirmation of deleting
application screen

Click [Yes] on the "Confirm delete userdata"
screen to delete user data

Click [No] if you do not want to delete user data.
« Even if you click [Yes], APN information is not deleted.

Setting Up
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M For Windows XP
« Mark "Clear communication settings (W-TCP setting)
(Recommended)” on the "Delete communication
settings" screen, then click [Next] to display the screen
in Step 4.

5 Click [Finish]

Uninstallation finishes.

« If communication settings (W-TCP setting) is deleted
under Windows XP, restarting is required.
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Installing L-O3F USB driver only

1

@ (Start) » Click "Control Panel" »
"Programs" » "Uninstall a program" »
"docomo LO3F", then click "Uninstall"

M For Windows XP
« [start] B Click "Control Panel" » "Add or Remove
Programs" » "docomo LO3F", then click [Removel.
Click [Yes] on the confirmation of deleting
application screen

3 Click [Finish]

M For Windows XP
« Click [Finish] on the setup wizard screen. If
communication setting (W-TCP setting) is unmarked,
restarting is required.
« |f the "Delete communication settings" screen appears,
select "Clear communication settings (W-TCP setting)
(recommended)" then click [Next].



Mac Version

Installation of L-O3F Connection Manager is only required
to install when connect this terminal to your PC for the
first time.

% The following images are the examples of "Mac 0S X 10.6.8".

Images may differ for "Mac 0OS X 10.7.2".

Note

« When installing, insert this terminal into USB port after 0S
is activated.

Do not remove this terminal while installing.

End all the applications before installing. Also end
programs on Mac OS including virus check software.
When installing, make sure to log in with PC supervisor
privileges.

When connecting this terminal to a PC for the first time,
you are required to enter PIN1 code to use UIM. =P58

Preparation before Using L-O3F

Setting via this Terminal

'I Turn on the PC and activate OS

Connect this terminal with the PC

CD-ROM icon is displayed on the desktop.

M For Mac OS X 10.7.2
CD-ROM icon does not appear by default. Make
settings to display CD-ROM icon in the following
steps.
- Finder in the menu bar » "Preferences..." » Mark "CDs,

DVDs, and iPods" checkbox.

3 Double click the CD-ROM icon

Setting Up
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4 Double click "Installer.mpkg" 6 Click [Continue]

- 5 Click [Continue]

Read "Software License Agreement" and click
"Agree" if you agree to continue installation
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8 Click [Install] ]0 Click [Continue Installation]

M If a selection screen for installation destination
appears
- Select an installation destination, click [Continue] »
[Install].

Select "Standard installation
(recommended)"”, click [Continue]

M To change installation destination
« Click [Change Install Location...], then specify
installation destination.

9 Enter administrator password » Click [OK]
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M Custom installation cSelect "ON (recommended)" or "OFF" on the "Automatic

aSelect "Custom installation”, click [Continue] connection setting" screen, then click [Continue]
bMake settings on the "Profile setting" screen, then click
[Continuel

'|2 Click [Restart]

The PC restarts. Installation finishes.
Remove this terminal from the PC temporarily.
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Confirming after Installation

Confirming L-O3F Connection Manager

w NN

Connect this terminal with the PC

Drag the CD-ROM icon displayed on the
desktop into trash bin
This terminal will be recognized as a modem.

Click [Network Preferences...]

M For Mac 0OS X 10.7.2
« Proceed to Step 6.

4 Select "docomo LO3F" and click [Apply]

5 Close "Network" screen

Setting Up
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6 Double click to launch Finder » "Applications" » M Installing Flash Player
A message appears when activating the L-O3F

n H 1]

L-OBF,ConnectlonfManager _Connectipn Manager for the first time if Flash F_’Iayer is not
When the following screen is displayed, the confirmation of installed in your PC. Install Flash Player following the
installation finishes. procedures below.

a Double click to launch Finder » "Applications" »
"L-O3F_Connection_Manager"

b Click [OK]

¢ Confirm the content of the License Agreement, check
"l have read and agree to the terms of the Flash Player
License Agreement." and click [INSTALL]
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d Enter administrator password and click [OK]

Uninstalling L-O3F Connection Manager

(including a driver)

« When uninstalling, make sure to log in with PC supervisor
privileges.

Connect to a PC
CD-ROM icon is displayed on the desktop.

2 Double click the CD-ROM icon
3 Double click "Uninstaller"

e Click [DONE]

Installation finishes.

Note
4 Click [Uninstall]

« When communicating data via L-O3F Connection Manager,
settings of L-O3F Connection Manager is required.—~P54
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5 Enter administrator password » Click [OK]

Click [Restart]
m 6

Remove this terminal from the PC
Uninstallation finishes.
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L-O3F Connection Manager is available on either Windows or Mac. Despite the display images of Windows version and
Mac version may differ, icons on screen and available functions are the same. Please note that the descriptions in this
chapter are based on screen images of Windows.
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L-O3F Connection Manager

The L-O3F Connection Manager allows you to use packet
communication.

» Using Packet Communication—P52

Enables to use packet communication easily.

» Configuration—P54, P92

Enables to confirm packet usage, set profile, set PIN1 lock for
UIM, set network (only during international roaming),
automatically connect, set language, check latest software,
reset this terminal, etc.

Note

« L-O3F Connection Manager cannot be activated while
L-O3F APN Tool is being operated.

"Access point name (APN)" on L-O3F Connection Manager
does not go with "APN (Access Point No.)" on L-O3F APN Tool.
For Windows 7, L-O3F Connection Manager may not be
activated depending on the setting of mobile broadband
auto connection. Set to "Never connect automatically”.

If use L-O3F Connection Manager, do not connect with
wired or wireless LAN.

Packet communication via L-O3F Connection Manager is
high speed NDIS type (similar to wireless LAN type). Dial-up
connection is also available. =P73

Mac supports only NDIS type.

L-O3F Connection Manager and dial-up connection cannot
be conducted at the same time.

L-O3F Connection Manager

Launching/Exiting Connection Manager

M For Windows

Connect to a PC
« L-O3F Connection Manager starts automatically and the
Home screen appears. (—P51)

M Exiting
« Click on the top of Home screen.

M For Mac

'I Connect to a PC

« When connected to a PC, the L-O3F is recognized as a CD-
ROM first and a CD-ROM icon appears on the desktop.
Drag the CD-ROM icon into trash bin to have the L-O3F
recognized as a modem.

2 Start Finder » Click "Applications" »
"L-O3F_Connection_Manager"

« L-O3F Connection Manager starts automatically and the
Home screen appears. (—=P51)
M Exiting
« Click "L-O3F Connection Manager" on the menu bar »
Quit L-O3F Connection Manager.

Note

- It may take some time before L-O3F Connection Manager
activates when this terminal is connected to the PC.



W Home screen during packet communication

a Version information button
« Click to display version information of LO3F Connection
Manager.
- Latest software can be checked. (—=P60)

b Operation tabs
« Tabs for Home screen and settings are functioning.

Home screen (—P51)

Setting screen (—P54)

¢ This terminal status area

Signal bar
@l @l @, @, ®
Strong « — Weak
P Not connected*®1/during packet communication
@ (with no sent or received data)*2
(Out of service) Out of service area/In the area
] : -
L with no signal

Network type
LTE WCDMA  W-CDMA3,
HSUPA HSUPA*4,

HSDPA HSDPA*4,
LTE LTE*5, GPRS GPRS*6

%1 Antenna bars for showing receiving sensitivity are only
displayed during packet communication.

%2 A long period with no sent or received data.

%3 "W-CDMA (3G)"

A third generation mobile communication network complying
with 3GPP Global standards. 3GPP means 3rd Generation
Partnership Project. The local standardization organization
established for the development of common technical
specifications related to 3rd Generation Mobile
Communication Systems (IMT-2000).

%4 "HSDPA" (Short for High Speed Downlink Packet Access)
"HSUPA" (Short for High Speed Uplink Packet Access)

A high speed type of W-CDMA data communication. It is called
"3.5G" since it is the improvement version of 3rd generation
(3G) cell phone, "W-CDMA".

%5 "LTE" (short for Long Term Evolution) is a technology level
between 3rd generation (3G) and 4th generation (4G) mobile
phone. It is known as "3.9G".

%6 "GPRS" (Short for General Packet Radio Service)

GPRS is the 2.5 generation mobile communication system
that enables high speed packet communication using GSM.
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52

d Connection status display area
« Connection status (Connected/Disconnected) is shown. If
no data communication is performed for a long time while
being connected, "Connecting (no data transmission)”
appears.
e Connect/disconnect Internet button
« Click to connect or disconnect Internet.
f Minimize button

+ The minimized window residents on Windows taskbar. To
reopen the minimized window, click &) on taskbar.

g Quit button
« Exit L-O3F Connection Manager.
h Carrier display area
« The name of the connected carrier is displayed.

« While international roaming, the name of the connected
carrier is displayed if "Operator name display" is set to
"Show". (—P92)

i APN name area
« Current APN name is displayed.

j  Own phone number area
« Own phone number is displayed.

L-O3F Connection Manager

Using Packet Communication

If Automatic connection setting is ON in the Setting
screen (—P59), connecting this terminal to a PC activates
L-O3F Connection Manager and enables packet
communication. On Mac 0S, activating L-O3F Connection
Manager while Automatic connection setting is ON enables
packet communication.
% Since Automatic connection setting is ON by default, packet
communication becomes available if L-O3F Connection
Manager is activated.

Starting Packet Communication

When Automatic connection setting is ON

Connect this terminal with a PC

« For Windows, L-O3F Connection Manager is activated
automatically.
For Mac, activate L-O3F Connection Manager manually.

« "Connected" appears for Connection status.




When Automatic connection setting is OFF Note

The default setting of APN is "mopera.net’. Set Profile
setting to change APN. -P55

A message of "Failed to connect. Do you want to try
again?" appears when connection fails. Check APN and
connect again.

If the PC goes to sleep or turns off while this terminal is
connected via packet communication, connection may not
be established after resume. Disconnect packet
communication and remove the terminal from the PC

» "Connected" appears for Connection status. before the PC goes to sleep or turns off.

Clicking with Automatic connection setting
ON does not reconnect automatically. To execute packet
communication again, click .

For Mac OS, when L-O3F communication device is not set,

« Set auto connection to OFF beforehand.

Connect this terminal with a PC

« For Windows, L-O3F Connection Manager is activated
automatically.
For Mac, activate L-O3F Connection Manager manually.

Click in Home screen

been set up. To set up this interface, use Network
Preferences." appears. Click [Network Preferences...] on
the screen. When "Network" screen appears, check
"docomo LO3F" is displayed and click [Apply]. Clicking
[Cancel] in the message box exits L-O3F Connection
Manager. Activate L-O3F Connection Manager again.
"User name", "Password", "Authentication method" for the
Profile setting (—P55) and Automatic connection setting
(—P59) are managed by user account.
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Disconnecting Packet Communication

Settings
] Click in Home screen Setting screen appears if clicking in Home
» Packet communication will be disconnected. screen.

« The Setting screen cannot be displayed during packet
communication. Disconnect packet communication to make

Note

« Clicking does not turn off Automatic
connection setting. Set Automatic connection setting to
OFF not to connect automatically.

- Packet communication may automatically be disconnected
depending on the network condition or location.

« In packet communication, fees apply on the amount of
sent/received data. Note that the communication fees may
become high if you perform heavy communication such as
browsing websites which include large multi-media
contents or downloading a large size of data.

- Depending on the auto connection setting of mobile
broadband of Windows 7, communication via mobile
broadband may start when L-O3F Connection Manager is
closed. Not to connect automatically, set to "Never
connect automatically” in auto connection setting of
maobile broadband. =P85

L-O3F Connection Manager

the settings.
Setting item
Used amount

Profile setting

DOCOMO UIM card
setting

Network setting

Automatic
connection setting

Language setting

Check latest SW
setting

Reset L-O3F

Description
Confirm packet usage.

Set basic items for packet
communication.

"Lock PINT", "Unlock PINT",

and "Change the PIN1
code" are available.

Settings for overseas use
such as roaming can be
made.

Set whether to
automatically connect to
the Internet.

Set language displayed on
the screen.

Set whether to
automatically check the
latest software.

Reset this terminal.

Page
P55
P55

P56

P92

P59

P59

PB0O

PB1



Confirming Packet Usage

« Check the amount of sending and receiving data.

Click "Used amount" in Setting screen
Packet usage is displayed.

Total use amount:
Accumulated total data usage

Use amount of this month:
Usage from 1st of this month to current

Previous use amount:
Data usage of current session

. Reset "Total use amount" and "Use amount of
this month", respectively.

: Click to reset all the amount.
Note

- The data usage displayed on the screen may differ from the
actual volume of packet communication.

Setting Profile

- Set basic items for packet communication.

'I Click "Profile setting" in Setting screen
2 Perform the following operations

Access point name (APN): APN for packet communication
User name: ID supplied by your provider

Password: Supplied by your provider

Authentication method: To enable to use this terminal
Tsst..: Click to change settings.

[Fwmisiza | : Click to return to default setting.

3 Click [Set]

A message to confirm is displayed.

4 Click [Yes]
5 Click [0OK]

L-O3F Connection Manager
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Note Locking PIN1

« "Connection type" is set according to the IPv4, IPv6 IP « Set security to UIM.
address setting by network settings in the OS. .

. Click [Set] to renew the settings. Always remember ta click Select "Lock PINT" in DOCOMO UIM card
when changing settings. setting screen

- |If ID or password is wrong, Internet connection cannot be
made.

Set the content of each profile according to the values
specified by each provider or network administrator.

Connection does not correctly perform with wrong Entering PIN1 code screen is displayed
settings. '
« You can connect to 'mopera U" even if "User name" and 2 Enter the PIN1 code set in UIM

"Password" are in blank.

___I Sctting a UIM

e "Lock PIN1", "Unlock PIN1" and "Change PIN1 code" are

available.
Click "DOCOMO UIM card setting" in Setting
screen 3 Click [OK]
DOCOMO UIM card setting screen is displayed. .
4 Click [0K]
Note

« If you lock PINT then remove and insert this terminal, PIN 1
code entry screen appears when L-O3F Connection
Manager restarts. Enter a correct PIN1 code to use this
terminal.
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Unlocking PIN1

Select "Unlock PIN1" in DOCOMO UIM card
setting screen

Entering PIN1 code screen is displayed.

2 Enter the PIN1 code set in UM

3 Click [0K]
4 Click [0K]

Note

« If PINT is unlocked, you can use UIM information from this
terminal without verifying PIN1 code.

Changing PIN1 Code

« Set the password required when unlocking or locking PIN 1.
« Changing PIN1 code is only available when PIN1 is locked.

Click [Change PIN1 code] in the DOCOMO
UIM card setting screen

Enter the current PIN1 code set in UIM in
"PIN1 code" field

3 Enter new PIN1 code in "New PIN1 code"

Enter a 4- to 8- digit PIN1 code.

4 In "Confirm new PIN1 code", enter the PIN1

code that has been entered in "New PIN1
code" code again

5 Click [Set]
6 Click [0OK]

L-O3F Connection Manager
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Entering PIN1 Code

« When L-O3F Connection Manager is started after setting PIN 1
lock or it is restarted to reset this terminal, PIN1 code input
screen will appear.

Enter PIN1 code
Enter the 4- to 8- digit PINT code.

2 Click [OK]
3 Confirm the result after entering PIN1 code

Ex.1 : When PIN1 code is entered correctly
Home screen of L-O3F Connection Manager is displayed.

Ex.2 : When PIN1 code is entered incorrectly

L-O3F Connection Manager

Ex.3 : When PIN1 code is entered incorrectly for 3
times in a row.
« |If you improperly enter the PIN1 code 3 times in a row,
the unblocking PIN code entry screen will be displayed.

M Unblocking PIN code setting
a Enter the unblocking PIN code set your UIM to "PIN
unlocking code"
b Enter a new PIN1 code in "New PIN1 code"
¢ In"Confirm new PIN1 code", enter the PIN1 code that
has been entered in "New PIN1 code" code again
d Click [Set]



Making Automatic connection setting

- Set whether to automatically connect to the Internet when
L-O3F Connection Manager is activated.

» Automatic connection setting is not available during
international roaming.

Click "Automatic connection setting" in
Setting screen

2 Select "ON (Recommended)" or "OFF"

3 Click [Set]
4 Click [OK]

Setting language

« Select Japanese or English as a display language for L-O3F
Connection Manager.

'I Click "Language setting" in Setting screen

2 Select "English" or "Japanese"

3 Click [Set]
4 Click [OK]

Caution

- If you select Japanese on an OS other than Japanese
version, specified settings or installations may be required.
For details on settings, contact your computer
manufacturer or Microsoft Corporation.

L-O3F Connection Manager
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Setting to check the latest software

- Set whether to automatically check the latest software each
time L-O3F Connection Manager is activated.

Click "Check latest SW setting" in Setting
screen

2 Select "ON" or "OFF"

ON : Check the latest software each time L-O3F
Connection Manager is activated.

OFF : Check the latest software by clicking
on the information screen of
L-O3F Connection Manager.

3 Click [Set]
4 Click [OK]

L-O3F Connection Manager

Checking the version information

Click @ on the title bar in the L-O3F Connection Manager
screen to display information about L-O3F Connection
Manager software.

: Click to check updates.

Note

- For information on how to update the software, see
"Updating Software". =P118

- Software update is not available on Mac 0OS. Update
software on Windows.



Resetting this terminal

Reset this terminal if it does not work properly.

'I Click in Setting screen

2 Click

This terminal starts resetting. After the reset finishes, it will -

return to the Home screen.
+« A message "L-O3F is not recognized" may temporarily be
displayed. This terminal will be detected after a while.

L-O3F Connection Manager 6]
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Mobile Broadband

Use the mobile broadband installed in Windows 7 to
communicate packet. Only Windows 7 supports mobile
broadband.

In this manual, operations such as connecting/
disconnecting mobile broadband, changing APN or setting
PIN lock are described.

Visit Microsoft website for detailed information.

For connecting this terminal with Internet, agreement with

the ISP (mopera U etc.) supporting service and data

communication is required.

Visit DOCOMO website for detailed information (Japanese

only).

% For the following procedures, description will be based on
the installation via only Communication Configuration File
(Driver).

« |f you use mobile broadband,. install the communication
configuration file (Driver) only.

64 Mobile Broadband

H APN screen

a Current APN
« While connecting mobile broadband, the current APN will
be displayed.
b APN list

« If click APN, "Connect" button/"Disconnect” button will be
displayed.



M Property screen for setting each item

a Setting tabs on Property screen

Subscription:Display provider details, own number, etc.

Profile : Set APN or auto connection. (—P66)
Roaming* : Select a network to use while roaming.

Security : When connecting mobile broadband, set PIN
authentication. (—P67)
¥ Display only during international roaming.

Connecting through Mobile
Broadband

Connect this terminal with a PC

W When connecting for the first time
a Click «0 (= if network connection is not made) or # in
the task tray displayed on the bottom right
b Right click "DOCOMO" and click "Connect"
¢ Set each item » Click "Continue"
« Enter APN in "APN" field.
- Enter the settings specified by your provider or
network administrator in "User name" and "Password".
« If connect to "'mopera U", connection is available with
"User name" and "Password" blank.
d Set auto connection »Click "Continue"
« Select from "Connect automatically except when
roaming", "Always connect automatically" or "Never
connect automatically" in pull-down menu.

2 Follow the auto connection setting on profile
tab to connect

M Connect automatically except when roaming
« Connect automatically while using in Japan. While
roaming, operations are the same as "l Never connect
automatically”.
M Always connect automatically
« Connect automatically after connecting with this
terminal.

B Never connect automatically
a Click .1 (= if network connection is not made) or # in
the task tray displayed on the bottom right
b Select "'DOCOMO" » Click [Connect]

Mobile Broadband
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Note

« A screen to confirm PIN1 code appears according to the Changing APN Settings

setting. Enter PIN1 code after the screen appears.

When mobile broadband is used to connect data

communication, L-O3F Connection Manager and dial-up

connection are not available.

"Disconnect" the mobile broadband or set auto connection

setting to "Never connect automatically” to enable to use

L-O3F Connection Manager or dial-up connection.

If select "Always connect automatically”, the amount of

packet transmission may go huge due to the long time

connection. Note that hefty fee may result.

- Note that communication fees may become high when
"Always connect automatically” is set during overseas use.

Connect this terminal with a PC

Click a0 (a# if network connection is not made)
or i@ in the task tray on the bottom right

Right click "DOCOMO" and click "Properties"

Click "Profile" tab » Set each item
Enter APN in "APN" field.

Enter the specified settings by provider or network
administrator in "User name", "Password" field.

If connect to "'mopera U", connection is available even if
"User name" and "Password" are in blank.

In "Autoconnect’ field, select from "Connect automatically
except when roaming", "Always connect automatically” and

2w N

Disconnecting Mobile

- Broadband "Never connect automatically”.
- If a PC accesses Internet via LAN, check the check box of
Click «f or @ in the task tray on the bottom "Autoconnect only if no alternate Internet connection is
. available" not to connect automatically on Windows.
right
5 Click [OK]

2 Select "DOCOMO" » Click [Disconnect]

66 Mobile Broadband



Setting UIM

« [Enable PIN...], [Disable PIN...] and [Change PIN...] can be
performed on UIM.

'I Connect this terminal with a PC

2 Click a1 (= if network connection is not
made) or @ in the task tray on the bottom
right

3 Right click "DOCOMO" and click "Properties"

4 Click "Security" tab » Set each item
« Set PINT lock in [Enable PIN...].
« Unlock PINT in [Disable PIN...]
« Change PIN1 in [Change PIN...].

Note

- If connect mabile broadband under PIN validation, PIN 1
code entry screen is displayed. In this case, this terminal
cannot normally function with wrong PINT code.

If entering PIN1 code is failed 3 times in a row, PIN code
will be locked. In that case, enter unblocking PIN code.

If entering unblocking PIN code is failed 10 times in a row,
UIM will be locked automatically. In that case, contact a

docomo Shop.

If set to PIN invalidation, mobile broadband connection is

available without confirming PIN1 code.

Mobile Broadband
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Windows Version

Setting APN Using L-O3F APN Tool

Set the settings required when connecting dial up manually
through L-O3F APN Tool.

Set the access point (APN) in packet communication of
dial-up connection. Up to 10 APN can be set up and they
are managed with cid's.

While L-O3F Connection Manager is activated, L-O3F APN Tool
cannot be activated.

The registration number (cid) 1 is pre-installed to mopera.net.
Use cid2 to cid 10 to set another APN.

For APNs other than "mopera U", contact your ISP or network
administrator.

'I Connect this terminal with a PC

Double click L-O3F APN Tool icon & (purple)
on the desktop
L-O3F APN Tool is launched.

70 Configuring Network Manually

3 Select "CID No." field to set » Click [Add/Edit]

H Deleting APN
a Select "CID No." field to delete
b Click [Remove]
¢ Click [Yes]
d Click [Save]
e Click [OK]

M Initializing APN
a Click [APN Reset]
b Click [Yes]
¢ Click [Save]
d Click [OK]



4 Enter the APN in "APN" field > Click [Set]

5 Click [Save]
Confirmation screen appears.
Click [0K]

The setting of APN finishes.

Setting APN Without Using L-O3F APN

Tool

Describe how to set an APN by using "Hyper Terminal"
attached on standard Windows XP.

- Windows 7 and Vista do not support "Hyper Terminal". Setting
with software compatible with each OS is required. For setting
instructions, refer to the instructions for each 0OS.

'I Connect this terminal with a PC

2 Click [start] »"All Programs" »
"Accessories"p "Communications" » "Hyper
Terminal"

Hyper Terminal starts.

Enter a connection name in "Name" field »
Click [0K]

Enter a number does not exist (like "0") in
"Phone number" field » Check that "docomo
LO3F Modem Driver" is displayed in "Connect
using" » Click [OK]

« If two or more modem names are displayed in the "Connect
using" field, check this terminal modem name and select a
proper one. (—P38)

Configuring Network Manually
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5
6

Click [Cancel] on connection screen
The Hyper Terminal screen opens.

Enter the APN in the following format
»Press

Enter AT+CGDCONT=<cid>,"<PDP type>""<APN>"[]

Enter the following information in the corresponding <cid>,

<PDP type> and <APN> sections.

If "OK" appears after you enter the information, the APN has

been setup.

cid Enter any number from 2 to 10.

¥ Keep in mind that the old setting
information will be overwritten if you select
a cid number which has been set.

. Enter a connection method. Enter IP enclosed
in guotation marks " ".

. Enter an (APN) enclose it in guotation marks

PDP type
APN

« If the entered .characters do not appear, enter ATE1 Rk
H To reset the specified cid APN settings

Enter AT+CGDCONT=<cid>[]

M To view the registered APN
Enter AT+CGDCONT?[d]

72 Configuring Network Manually

7
8
9

Confirm if "OK" is displayed
Click "File" » "Exit"

Click [Yes] on confirming disconnection
screen » Click [No] on the confirming to save
screen

Hyper Terminal quits, and the settings of the APN complete.

Note

The APN information is saved in this terminal. If you
connect a different terminal, save the APN information
again.

If you want to use the APN information registered on the
PC. register the same APN in the same cid of this terminal.
When setting connection through PDP type, enter the
specified content by each provider or network
administrator.



3 Select "Set up a dial-up connection" » Click
Configuring Dial-up Network Manually [Next]

Set up the dial-up network on the PC.

« For setting up a connection to other than "'mopera U", contact
your ISP or network administrator.

Example: Connecting to the DOCOMO Internet connection
service "mopera U", which is registered to <cid>=1

For Windows 7

Click @ (Start) » "Control Panel" » "Network
and Internet" » "Network and Sharing Center"

2 Click "Set up a new connection or network"
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4 When the modem selection screen appears,
click "docomo LO3F Modem Driver"

The modem selection screen opens only if two or more
modems are connected to a PC.

74 Configuring Network Manually

Configure each setting, then click [Connect]
« Enter *99**<cid># in the "Dial-up phone number". Enter
the registration number of an APN set in <cid>. (=P70)

 Enter the user name and password specified by your ISP or
network administrator in the "User name" and "Password"
fields.

» You can leave the "User name" and "Password" fields
unfilled when connecting to "'mopera U".

- Enter a connection name in the "Connection name" field.



6 Click "Skip" on the "Connecting to (APN)..." Click @ (Start) » "Control Panel" » "Network
screen and Internet" » "Network and Sharing Center"
The connection test will not be performed. Only the settings " : "
will be chacked. Change a?daptt.ar settln_gs > _Select Tche

created dial-up icon » Right click the icon and
select "Properties"

Check the settings on the "General" tab

window

If two or more modems are connected to a PC, enable only
"Modem - docomo LO3F Modem Driver” in the "Connect using”
field.

« Disable "Use dialing rules".

7 Click [Close]
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'” Click "Networking" tab » Configure each Click the "Options" tab » Click [PPP

setting Settings...]
The settings for "QoS Packet Scheduler” in "This connection . i
uses the following items" field should follow your ISP or ]3 Remove check marks from all items » Click

network administrator. Do not change the other items.

« When the IP and DNS information settings are requested
by your ISP, etc., select "Internet Protocol Version 6 (TCP/
IPvB)" or "Internet Protocol Version 4 (TCP/IPv4)", then
click "Properties" to make the settings. For setting details,
contact your ISP or network administrator.

[OK]

'|4 On the "Options" tab window, click [OK]
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Ear o e 3 ﬁ\?éexi; Set up a dial-up connection" » Click

'I Click @ (Start) » "Connect to"

2 Click "Set up a connection or network"
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4 When the modem selection screen appears,
click "docomo LO3F Modem Driver"

The modem selection screen opens only if two or more
maodems are connected to a PC.

78 Configuring Network Manually

Configure each setting, then click [Connect]
« Enter *99**<cid># in the "Dial-up phone number". Enter
the registration number of an APN set in <cid>. (=P70)

 Enter the user name and password specified by your ISP or
network administrator in the "User name" and "Password"
fields.

» You can leave the user name and password fields unfilled
when connecting to "mopera U".

- Enter a connection name in the "Connection name" field.



6 Click [Skip] on the "Connecting to (APN)..." Click "Set up the connection anyway" »
screen [Close]

The connection test will not be performed. Only the settings

will be checked.

« |f you do not click [Skip], the connection to the Internet will
be established.

8 Click @ (Start) » "Connect to"

Select the created dial-up connection icon »
Right click "Properties"
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Check the settings on the "General" tab
window
If two or more modems are connected to a PC, enable only

"Modem - docomo LO3F Modem Driver" in the "Connect using"

field.
« Disable "Use dialing rules".

80 Configuring Network Manually

'” Click "Networking" tab » Configure each item

The settings for "QoS Packet Scheduler” in "This connection
uses the following items" field should follow your ISP or
network administrator. Do not change the other items.

« When the IP and DNS information settings are requested
by your ISP, etc., select "Internet Protocol Version 6 (TCP/
IPvB)" or "Internet Protocol Version 4 (TCP/IPv4)", then
click "Properties" to make the settings. For setting details,
contact your ISP or network administrator.



2 Click the "Options" tab » Click [PPP For Windows XP

Settings...]
Click [start] » "All Programs" »
]3 Remove check marks in all items » Click [OK] "Accessories” » "Communications” » "New
Connection Wizard"

On the "New Connection Wizard" screen, click
[Next]

'|4 On the "Options" tab window, click [OK]
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Select "Connect to the Internet" » Click Select "Connect using a dial-up modem" »

[Next] Click [Next]
Select "Set up my connection manually" » 6 If "Select a Device" screen appears, check in
Click [Next] "Modem - docomo LO3F Modem Driver" check

box » Click [Next]

The "Select a Device" screen appears only if two or more
modems are connected to a PC.
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Enter a name in the "ISP Name" field » Click
[Next]

Enter the APN number in the "Phone number"
field » Click [Next]

« Enter *9Q9**<cid>#". Enter the registered number of APN
in <cid>. (=P70)

9 Select the connection usage range » Click
[Next]
Select a user.

« Depending on the PC settings, this screen may not
appear.

0 Fill in the "User name", "Password", and
"Confirm password" fields » Click [Next]

Enter the information provided by your ISP or network

administrator.

« Enter "User name" and "Password" correctly according to
the instruction from the provider. Pay attention to the
capital characters.

- For "mopera U", connection is available with "User name”
and "Password" blank.

Configuring Network Manually
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'| '| Click [Finish] Select the created dial-up connection icon »
Right click » Click "Properties"

]2 Click [start] » "All Programs" »
"Accessories" » "Communications" »
"Network Connections"

84 Configuring Network Manually




Check the settings on the "General" tab
window

- If two or more modems are connected to a PC, enable only
"Modem - docomo LO3F Modem Driver" in the "Connect
using" field.

« Disable "Use dialing rules".

'|5 Click the "Networking" tab » Confirm each

item
« Select "PPP: Windows 95/98/NT4/2000, Internet" in the
"Type of dial-up server | am calling" field.

- Do not change the settings in "This connection uses the
following items" field.

« When connecting to a provider, to confirm the TCP/IP
settings contact the provider or network administrator.

Configuring Network Manually
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]6 Click [Settings]
]7 Remove check marks from all items P Click Communicating (Connecting by Dial-up)

[OK] This section describes steps to start and terminate
communication without using L-O3F Connection Manager
or Mobile Broadband.

« Check whether this terminal and the PC are connected properly
before starting communication. (—=P20)

- When performing communication, connect this terminal you
used to configure the settings. If a different terminal is
connected, L-O3F Connection Manager (including a drivers)

]8 Click [OK] on the "Networking" tab window may need to be reinstalled.

« When set PIN1 lock using L-O3F Connection Manager, start
after unlocking PINT.
'I Click € (Start) » "Control Panel" » "Network
and Internet" » "Network and Sharing Center"
» "Change adapter settings" » Double click
the set APN icon

M For Windows Vista
« Click @ (Start) » "Connect to" » Select the set APN »
Click [Connect].

M For Windows XP

- « Click [start] » "All Programs" B "Accessories" »

"Communications" » "Network connections" » Double
click the set APN icon.
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Enter "User name" and "Password" » Click
[Dial] Disconnecting Communication

The APN will be connected. . .
« To connect to "mopera U’, you can leave the " User name” Exiting the Internet browser may not terminate the

and "Password" fields unfilled and click [Dial]. If another ISP | connection. Perform the following steps to terminate the
or dialup connection is selected, fill in the "User name" and connection securely.

"Password" fields and click [Diall. ] Ciick W (dial-up icon) on the task tray of a PC
You can save the user name and password or just the

password to skip entering them next time.
Depending on the operating system, a connection 2 Select an APN p» Click [Disconnect]
completion screen may appear when the dial-up
connection is established. However, the connection
completion screen does not appear if you previously set
the completion message not to appear.

A screen indicating the connection status appears.

Communication is disconnected.

M For Windows Vista

« Click "Connect or disconnect..." » "Disconnect”.
M For Window XP

« Click [Disconnect].

Note

» The communication speed shown on the PC screen may be
different from the actual communication speed.
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International Roaming Service
(WORLD WING)

International roaming service enables you to use this
terminal domestically in a service area of international
carrier associated with DOCOMO.

M Available area
This terminal can be used in 3G network and
GPRS network service areas. Also, it can be used in the
countries and areas that support 3G850MHz. Check
available areas.
« Before using this terminal overseas, see the following items.
- "Mobile Phone User's Guide [International Services]"
- DOCOMO International Services website
For areas out of Xi area such as overseas, connect to 3G or
GPRS network.

90 Overseas Use

Services Available Overseas

Service Description

Available for data communication
using packets communication.

Data Communication

Note

« For details on available communication services while
using international roaming, refer to Mobile Phone User's
Guide [International Services] or visit DOCOMO
"International Service Website".

« |-O3F does not support voice call or video telephony
features.



Before Using Overseas

STEP1 : Before Leaving Japan
STEP2 : While Overseas
STEP3 : After Coming Back to Japan

Before Leaving Japan

H Subscription
« "WORLD WING" is always applied together with your
subscription. Contact My docomo, docomo Shop or docomo
Information Center for details.
« A UIM made available for "WORLD WING" must be inserted
in this terminal.

W Power source and voltage in the country or region of
stay
- Countries and regions may have different power sources,
voltages or power outlet shapes. Check these in the
INSTRUCTION MANUAL for your PC or websites of the PC
manufacturer in advance.

Hl Network setup
« You can change network setup from overseas. (—P92)

M Usage charge
« The charge for usage (bill for packet communication)
abroad is different from the charge in Japan.

M Internet access
« For overseas access points or settings for using the
Internet overseas, contact your ISP.
- |f you subscribe to mopera U, visit the mopera U website.
http://www.mopera.net/ (Japanese only)

W Automatic connection for Mobile Broadband
- Note that if you use packet communication overseas using
Windows 7 mobile broadband with the automatic connect
setting to "Always connect automatically”, (—P65)
communication fees may become extremely high.

While Overseas

M Switching networks
Available networks are detected automatically by default.
M Home screen
The name of the connected carrier is displayed if
"Operator name display" is set to "Show". (—P92)
Also the information of the Internet being connected is
displayed. (—»P51)

Note

« You can manually switch networks if you want to connect
to a particular network. See Step 3 of "Configuring
Network". -P93

Inquiries overseas

If your UIM is lost or stolen overseas, contact DOCOMO
immediately and temporarily suspend your subscription.
For inquiry information, see "docomo Information Center"
on the back of this manual. Call or data communication
charge will still on you after the terminal was lost or stolen.

Overseas Use
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After Coming Back to Japan

After coming back to Japan, you can use within Xi area or

FOMA area.

M If connection cannot be established
Set "3G/GPRS switching" in "Network setting" (—P92) to
"Automatic” and "Network discovery method" to
"Automatic search".

Setting the Searching Method
for Available Networks

Switching Carriers Manually

This terminal is set to automatically find and switch to an
available network in the country of stay by default.
However, if you have a preferred network in the area or
network cannot be found automatically, you can set to a
network manually. For details, see Step 3 of "Configuring
Network". (—P93)

92 Overseas Use

Configuring Network

« Allow you to configure network by L-O3F Connection Manager.
- Available if you come back to Japan with international roaming
set or "Manual search’ for "Network discovery method" selected
during international roaming.
'I Click "Network setting" in Setting screen
(—P54)

2 Specify a network to connect under "3G/
GPRS switching"



3 Specify a search method from "Network
search method"

M [Automatic search]
Network can be searched automatically.

M [Manual search]*
« Connect to the listed networks manually.
« How to manually configure network
- Select [Manual search].
- Click [Yes].

- The available network list will be displayed after searching.

(O): Available, (X): Unavailable are shown after
the detected network operators name.
- Select one from the available networks.
- Click
- Click [Yes].
% If you manually select a network overseas, reset to
"Automatic search" after coming back to Japan.

Specify whether to show or hide the network
information in "Operator name display"

M [Show]
« The name of the network receiving current service is
displayed on the screen.

M [Hide]
« The name of the network receiving current service is
not displayed on the screen.

5 Click the applicable

« The information entered will not be set without clicking the
applicable

6 Click [Yes]
7 Click [Close]

Note

- Connecting to Internet may not be able to operate properly
when network settings are changed manually.

Overseas Use
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Note

« While using overseas

- If "Network search method" is set to "Automatic search’,
this terminal will search the available carrier
automatically and connect again if move to an area out
of service.

- Some communication services may not be available

depending on the overseas carrier or network.

If you set only "Internet Protocol Version 6 (TCP/IPvB)"

under Windows 7 or Windows Vista, you may not

connect to the Internet overseas. If a message
notifying unavailability of Internet connection, mark

"Internet Protocol Version 4 (TCP/IPv4)" on the

properties screen for "Mobile Broadband connection” or

"Local area Connection” in "docomo LO3F USB NDIS

Driver', the device name for network settings, to change

the setting.

Overseas Use
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AT Commands

AT commands are used to check this terminal function
settings or status by using a PC. Usually, the
communication software issues AT commands so you do
not need to be concerned about them. Use AT commands if
you want to control this terminal in your own way.

Form of AT Commands

AT commands should be entered on the Terminal Mode
screen of the communication software. Use only single-
byte alphanumeric characters.

<Example>

ATD * 99 * % % 1#

LHard Return
Parameter: Content

Command Name

« An AT command must be entered on a single line including
parameters (numbers and symbols) following the command. On
the Terminal Mode screen of the communication software,"one
line" is from the first character to the character before .

Note
« In the Terminal mode, a PC functions as a communication

terminal. Characters entered from the keyboard are sent to
a line connected to a communication port.
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AT Command List

The following AT commands can be used on the "L-O3F" modem port.
« [&F] : A command to initialize settings used as AT&F command.

« [?][=7]:The current settings appear when adding "?" at the end of the command, and the effective range of the current
settings appears when adding "=?" at the end of the command.

Command

AT

AT&C<n>
[&F]

AT&D<n>
[&F]

AT&F<n>

AT+CEER

Overview

OK is displayed.

Select the operating conditions of
the circuit CD signal for TE.

Select the operation when receiving
circuit ER signal from TE.

Reset the settings on this terminal
with the nonvolatile memory
contents. If performed during a
communication, the line is

disconnected.

Set up error report is displayed.

Parameters/Description

n=0: Always keeps CD signal ON
n=1 (default): CD changes depending on the
other party's modem status.

n=0 : Same as n=2
n=1:Same as n=2

n=2 (default) : If ER signal is changed from
ON to OFF, line will be disconnected and
become offline command.

Only n=0 can be set (Skippable)

Examples of
Commands

AT
OK

AT&CT
oK

AT&D1
oK

ATS&F
OK

AT+CEER
+CEER: 36

oK
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Command Overview Parameters/Description Examples of

Commands
AT+CEREG=<n> Set if notify EPS network <n>: Set if send unsolicited result code AT+CEREG?
[&F] registration. n=0 : Do not send unsolicited result code +CEREG:
(7] [=7] (default) 2,100C3"'01"'00

n=1 : Send network registration status as ooc4D17
unsolicited result code

n=2 : Send network registration status and | OK
location information as unsolicited result

code

<stat> : Packet data exchange network
registration status

stat=0 : Outside area and not searching
stat=1 : Within area (HOME)

stat=2: Outside area and Attach or searching
stat=3 : Registration is refused

stat=4 : Unclear (other)

stat=5 : Within area (while roaming)

<lac> : Location area code
This parameter is string parameter. It will be
surrounded by ™. Notation as a hex of 2byte.

<ci> : Cell ID
This parameter is string parameter. It will be
surrounded by "'. Notation as a hex of 4byte.

<AcT> : Within area
AcT=0 : GSM
AcT=2 : 3G (FOMA)
AcT=7 : LTE (Xi)

<rac> : Routing area code
This parameter is string parameter, it will be
surrounded by "'. Notation as a hex of 1byte.

AT+CGDCONT Set APN when sending Packet Referto P111 Referto P111
[?1[=7] communication.
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Command

AT+CGEQMIN
[?] [=7]

AT+CGEQREQ
[?] [=7]

AT+CGMR

Overview Parameters/Description

Register criteria value for RefertoP111
determining if QoS (Quality of

Service) sent from network when

PPP Packet communication is

established is acceptable or not.

Set QoS(Quality of Service) to
request for the network when PPP
Packet communication starts.

Display IMEISV value of this
terminal.

Referto P111

Examples of
Commands

RefertoP111

RefertoP111

AT+CGMR
1234512345123
456

oK
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Command

AT+CGREG=<n>

[&F] registration.

[?1 [=7]

AT+CGSN Display the serial number of this
terminal.

Ioo Appendix/Troubleshooting

Set if notify GPRS network

Parameters/Description

<n>: Set if send unsolicited result code
n=0 : Do not send unsolicited result code
(default)

n=1 : Send network registration status as
unsolicited result code

n=2 : Send network registration status and
location information as unsolicited result
code

<stat> : Packet data exchange network
registration status

stat=0 : Outside area and not searching
stat=1 : Within area (HOME)

stat=2 : Outside area and Attach or
searching

stat=3 : Registration is refused

stat=4 : Unclear (Other)

stat=5 : Within area (while roaming)

<lac> : Location area code
This parameter is string parameter. It will be

surrounded by ". Notation as a hex of 2byte.

<ci> : Cell ID
This parameter is string parameter. It will be

surrounded by "". Notation as a hex of 4byte.

<AcCT> : Within area
AcT=0 : GSM
AcT=2 : 3G (FOMA)
AcT=7 : LTE (Xi)

<rac> : Routing area code
This parameter is string parameter. It will be

surrounded by "'. Notation as a hex of Thyte.

Examples of
Commands

AT+CGREG?
+CGREG:
2,1,"00C3","0000C
4D1'2"01"

OK

AT+CGSN
12345678901
2345

OK



Command Overview Parameters/Description Examples of

Commands
AT+CIND The signal status of this terminal is | <battchg> AT+CIND?
[?]1 [=7] displayed. Execute "AT+CIND="", battchg=0~5 : Battery charge level +CIND:5,5,1
then appears as * Not supportive.
"+CIND:<battchg> <signal>,<servi oK
ce>". <signal>

signal=1: 0 or 1 bar of antenna is displayed | AT+CIND="

signal=3 : 2 bars of antenna are displayed +CIND:("battchg".(0

signal=5 : 3 bars of antenna are displayed -5)).("signal",(0-
5)).("service".(0, 1))

<service>
service=0 : Out of area OK
service=1 : Within area
AT+CLCK=<fac><mod | Change PIN lock setting and inquire | <fac>: Lock type AT+CLCK="SC".0,"0
e>[,<passwd>] the setting items. fac="SC" : Operation of setting UIM PIN lock | 000"
[=7]
<mode>: Lock control OK
mode=0 : Unlock PIN lock
mode=1 : Set PIN lock AT+CLCK="SC".2
mode=2 : Status of PIN lock +CLCK:1
<passwd>: PIN code OK
Execute "AT+CLCK="SC",2", then appears as
"+CLCK:<state>".

<state>: Lock status
O : PIN is unlocked
1 : PIN is locked
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Command Overview
AT+CMEE=<n> Set the error report form of this
[&F] terminal.

[?1 [=7]
AT+ CNUM Display the own number of this
terminal.
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Parameters/Description

n=0: Display "ERROR". (default)

n=1: Display in the form of "+CMEE ERROR:
Xxxx" (where xxxx are numbers)

n=2: Display in the form of "+CMEE ERROR:
XxxX" (where xxxx are text)

¥ If using ATZ or AT&F command to default,
'0" is setup.
Note that when connecting L-O3F to
power, the value of ATZ or AT&F
command differs.

Executing "AT+CNUM" displays in the form of
"+CNUM: <number>, <type>".

number: phone number

type=129: Excluding the international
access code+

type=145: Including the international
access code+

Examples of
Commands

AT+CMEE=0
oK

AT+CMEE?
+CMEE.O

oK

AT+CMEE="?
+CMEE:(0-2)

oK

AT+CNUM
+CNUM:
.'09012345678".1
29

OK



Command

AT+COPS=
(<mode> (<format>
(<oper> (<AcT>
1))

[?] [=7]

Overview

Select network operator and set.

Parameters/Description
<mode> Parameter is supporting O-4.

<format> Parameter is only supporting
2(default).

<oper> MCC+MNC
For example, if PLMN Number is 440 (MCC)
10 (MNC), <oper>="44010".

<stat> Parameter is supporting the
followings.

stat=0 : unknown

stat=1 : available

stat=2 : current

stat=3 : forbidden

<AcT>: Within area
AcT=0 : GSM
AcT=2 : 3G (FOMA)
AcT=7 : LTE (Xi)

Examples of
Commands

AT+COPS=0
OK

AT+COPS?
+COPS:0

OK
AT+COPS=1.2"44

0107
OK
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Command Overview

AT+CPAS
[=7]

Display this terminal state.

AT+CPIN="PIN"/
AT+CPIN="PUK" , "PIN"
[?]

Command to enter the PINT code or
unblocking PIN code for UIM.

AT+CPWD=<fac>,<old
pwd> <newpwd>
[=7]

Change password of PIN1 code.
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Parameters/Description
Displays in the form of "+CPAS : <n>".

n=0: Available

n=1: Unavailable

n=2: Unclear

n=3: Available and while incoming call
receiving

n=4: Available and communicating

Enter the PIN1 code for "PIN", and enter
unblocking PIN code for "PUK".

Executing "AT+CPIN?" displays "+CPIN:
<n>".

n=READY: Authenticated

n=SIM PIN: Waiting for entry

n=SIM PUK: Waiting for

unblocking PIN code entry

n=ERROR: Locked

<fac>
fac="SC": Change PIN1 code of UIM

<oldpwd><newpwd>means enter the
current PIN code and new PIN code.
Execute "AT+CPWD="", then appears
as'+CPWD:("SC" . <pwdlength>)".

<pwdlength> displays maximum character

number of PIN.

Examples of
Commands

AT+CPAS
+CPAS:0

oK

(+CPIN:SIM PIN
status)
AT+CPIN="1234"
oK

(+CPIN:SIM PUK
status)
AT+CPIN="123456
78", "1234"

oK

AT+CPWD="SC",
"0000", "T111"
OK



Command

AT+CR=<mode>
[&F]
[?1 [=7]

AT+CREG=<n>
[&F]
[?] [=7]

AT+CSQ
[=7]

Overview

Set if display service report.

Set if notify EPS network

registration and make an inquiry.

Display the wireless quality of this

terminal.

Parameters/Description

<mode>
O : Do not return report (default).
1 : Return report.

<n>: Set if send unsolicited result code

n=0 : Do not send unsolicited result code
(default)

n=1 : Send network registration status as
unsolicited result code

n=2 : Send network registration status and
location information as unsolicited result
code

<stat> : Packet exchange network
registration status
n=0 : Outside area and not searching

Execute "AT+CSQ", then appears as
"+CSQ:<rssi>,<ber>".

<rssi>

rssi=0 : Under -1 13dBm
rssi=1:-111dBm

rssi=2~30 : -109dBm~-53dBm
rssi=31 : Over -51dBm

rssi=99 : Unclear or not detected

<ber>
ber=0~7 : Bit Error Rate, RXQUAL
ber=99 : Unclear or not detected

Examples of
Commands

AT+CR=0
OK

AT+CR?
+CR:0

OK

AT+CREG=0
oK

AT+CREG?
+CREG:0.0

OK

AT+CSQ
+CSQ:31.7

oK
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Command Overview Parameters/Description Examples of

Commands
AT+GCAP Display the capability list of this - AT+GCAP
terminal. +GCAP: +CGSM,+W
OK
AT+GMI Display the manufacturer of this - AT+GMI
terminal. LG Electronics Inc
OK
AT+GMM Display the name of this terminal. - AT+GMM
docomo LO3F
oK
AT+GMR Display the S/W version of this - AT+GMR
terminal. LO3F-MDMS200-
VXXK-XXK-XX-
XXXX-DCM-JP
OK
ATHFC=<n><m> Set the local flow control method n : DCE by DTE control AT+HIFC=2,2
[&F] between the PC and this terminal. n=0 : No flow control. oK
[?]1 [=7] n=1 : Perform XON/XOFF flow control.
n=2 (default): Perform RS/CS (RTS/CTS) ATHFC=1,1
flow control. OK
m : DTE by DCE control
m=0: No flow control AT+HFC=0.0
m=1: Perform XON/XOFF flow control. oK
m=2(default) : Perform RS/CS (RTS/CTS)
flow control
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Command Overview Parameters/Description Examples of

Commands
AT+HWS46=<n> Set the wireless network to be used | n=12 : 3GPP Systems AT+WS46=12
[?1 [=7] by this terminal when dialing. *For AT+WS46 ? |, the answer is only 25. oK
AT+WS4867?
25
OK
A/ Retry a command just before is not needed after entering command. | A/
performing. oK
ATA Display NO CARRIER under offline - ATA
command mode. NO CARRIER
ATD Send packet. Sending packet : ATD*Q9***<cid># ATD*99#
<cid>1~10 : + Display the APN that CONNECT
configured +CGDCONT
ATE<n> Set whether to echo back the text | n=0 : Not echo back. ATEO
[&F] sent from a PC. n=1(default) : Echo back. OK
ATE]
OK
ATH<N> The line is disconnected. Only n=0 (default) can be specified. ATH
OK
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Command Overview Parameters/Description

ATI<Nn> Display the recognition code. n=0 : Display [NTT DOCOMO, INC.]

n=1 : Display the name of this terminal
(Same as +GMM).

n=2 : Display this terminal version (same as
+GMR).

n=3 : Display OK.

n=4 : Display the details of communication
functions of this terminal.

ATSO=<n> Set the BING value while receiving n=0 (default) : Cannot receive automatically.
[&F] [?] automatically. n=1~255 : Receive automatically by
specified RING value.

Ios Appendix/Troubleshooting

Examples of
Commands

ATI
NTT DOCOMO, INC.

oK

ATIO
NTT DOCOMO. INC.

OK

ATIT
docomo LO3F

OK

ATI2
LO3F-MDM9200-
VXXX-XXXK-XX-
XXXX-DCM-JP
oK

ATI3
oK

ATI4
4

oK

ATSO=0
OK

ATSO?
000

OK



Command

ATS3=<n>
[&F] [7]

ATS4=<n>
[&F1 [?]

ATSE=<n>
[&F] [?]

ATSB=<n>
[&F] [?]

ATS8=<n>
[&F] [?]

ATS10=<n>
[&F] [7]

ATQ<n>
[&F]

ATV<n>
[&F]

Overview

Set the return character (CR) to
recognize the end of AT command
text string.

Set the line feed (LF) character. It is
positioned next to the return
character (CR) if displaying the
result code in English characters.

Set the back space (BS) character
to delete the last character in the
input buffer while AT commands are
entered.

Set pause duration (seconds) till
dial.

Set pause duration (seconds) of
comma dial.

Set delay duration of auto
disconnection (1/10 seconds).

Set if display result code.

Set the display method of the result
code.

Parameters/Description

Only n=13 (default) can be specified.

Only n=10 (default) can be specified.

Only n=8 (default) can be specified.

This command can be set but is not
functional.

This command can be set but is not
functional.

This command can be set but is not
functional.

n=0 (default) : Display result code.
n=1 : Not display result code.

n=0 :Display in numeric characters.
n=1(default): Display in text.

Examples of
Commands

ATS3=13
OK

ATS4=10
oK

ATS5=8
oK

ATS6=5
OK

ATS8=3
oK

ATS8?
003

OK

ATS10=1
OK

ATS10?
001

OK

ATQO
oK

ATV1
OK
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Command Overview
ATX<n> Set if detect dial tone.
[&F]
ATZ Reset the settings on this terminal

with the nonvolatile memory
contents. If performed during a
communication, the line is
disconnected.
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Examples of

Parameters/Description Commands

n=0 : No busy tone detected, no dial tone ATX1
detected, no speed display OK
n=1 : No busy tone detected, no dial tone
detected, speed display detected

n=2 : No busy tone detected, dial tone

detected, speed display detected

n=3 : Busy tone detected, no dial tone

detected, speed display detected

n=4 (default) : Busy tone detected, dial tone
detected, speed display detected

ATZ
OK



Supplementary Explanation of AT

Commands

M Command name : +CGDCONT

« Qverview
Set APN when sending packet connection.

« Form
+CGDCONT=[<cid>[,"<PDP type>"[."<APN>"]]

« Parameter descriptions

Set the destination (APN) when sending packets. See

the following examples for command operations.

<cid>*1:11t0 10

<PDP type>#*2 : |P

<APN>*3 : Optional

% 1 <cid> is the number used to control the destination
(APN) for the packet communication to be registered in
this terminal. 1 to 10 can be registered.
The default value of <cid>=1 is "mopera.net". Set cid
number from 2 to 10.

%2 <PDP type> is a protocol for packet communication.
The pre-installed <PDP type>=IP is set to <cid>=1 as
default.

%3 <APN> is optional string that indicates each destination.

« Command examples
Command to register an APN with the name of abc
(When PDP type is IP, cid is 2)
AT+CGDCONT=2,"IP","abc"
oK

« Operations without a parameter
AT+CGDCONT=": Clear all the settings of <cid>.
However, the setting of <cid>=1 is reset to the value
when purchasing.
AT+CGDCONT? : Display the current settings.

H Command name: +CGEQMIN=[Parameter]

.

Overview

Register the threshold to accept the QoS (Quality of
Service) sent from the network when packet
communication is established.

LTE data communication is not supported.

Format
+CGEQMIN=[<cid>[,.<Maximum bitrate UL>[,<Maximum
bitrate DL>]]]

Parameter description

<cid>*1:11t0 10

<Maximum bitrate UL>*2 : None (default)

<Maximum bitrate DL>*2 : None (default)

% 1 <cid> is a number used to manage the access point
(APN) for the packet communication registered in this
terminal.

%2 <Maximum bitrate UL> and <Maximum bitrate
DL>indicate the minimum communication speed [kbps] of
upload and download traffic respectively between this
terminal and the base station. If these are set to None
(default), all speeds are permissible. Be aware that a
packet communication may not be established because
any other speed than this is not permissible.

Command examples

(1) Command to permit all speeds for both upload and
download (When cid=2)
AT+CGEQMIN=2
oK

(2) Command to permit only 5,760kbps for upload and
7,232kbps for download (When cid=2)
AT+CGEQMIN=2,5760,7232
oK

(8) Command to permit 5,760kbps for upload and all speeds
for download (When cid=2)
AT+CGEQMIN=2,5760
oK
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(4) Command to permit all speeds for upload and only
7,232kbps for download (When cid=4)
AT+CGEQMIN=4,,,7232
oK

H Command name: +CGEQREQ=[Parameter]

» Overview
Set the QoS (Quality of Service) requested to the
network when packet communication is dialed.

« Format

+CGEQREQ=[<cid>[..<Maximum bitrate UL>[,.<Maximum

bitrate DL>]]]

« Parameter description

<cid>*1:11t0 10

<Maximum bitrate UL>*2 : None (default)

<Maximum bitrate DL>*2 : None (default)

% 1 <cid> is a number used to manage the access point
(APN) for the packet communication registered in this
terminal.

¥ 2 <Maximum bitrate UL> and <Maximum bitrate
DL>indicate the minimum communication speed [kbps] of
upload and download traffic respectively between this
terminal and the base station. If these are set to None
(default), Qos of network is not required.

« Command example

Command to require 5,760kbps for upload and

7,232kbps for download (When cid=2)

AT+CGEQREQ=2,2,5760,7232

oK

Note

« This command, (+CGDCONT, +CGEQMIN, + CGEQREQ) is
not reset by [&F] and [Z], either.

'| ]2 Appendix/Troubleshooting

Result Codes

M List of result codes

Numeric

Sisplay Text display Description
0 oK Operation performed properly
1 CONNECT Connected to other party
3 NO CARRIER Line disconnected
ERROR Unable to accept command
100 RESTRICTION Network restriction display

Options and related devices

Combining this terminal with optional accessories
supports a wide variety of uses from personal use to
business use. Some merchandise are not available in some
regions.

For details, contact a docomo Shop. For details about the
optional devices, refer to the instruction manual for each
device.

« Back Cover L30



Troubleshooting

First, check whether software is required to update.
Update software if necessary. (Updating Software=P118)
Contact General Inquiries specified by DOCOMO located in
"Repairs" (Japanese only) at the last page of the manual if
the symptom is not improved after confirming the item to

check.

M This terminal is not recognized

Symptom

This terminal is
not recognized

Check
Insert the USB port firmly into this terminal.

Verify the L-O3F Communication
Configuration Files (Drivers) for this terminal
functioning properly.—P31, P41

This terminal may not be recognized correctly
when activating the PC with this terminal
being connected, during restarting or after
retrieving from the states of standby
(sleeping)/stopping during packet
communication. Remove this terminal from
the PC and insert again after restarting the
PC.

Delete the driver of this terminal on device
manager when "!" appears in this terminal
device. Only install the driver again.

The UIM will not be able to use if PINT unlock
code is wrongly entered 10 times in a row. For
further information, visit docomo Shop.

Symptom

Check

This terminal is | lIf CD/DVD playback and written software is

not recognized

installed into a PC
Depending on the CD/DVD playback or
writing application installed in a PC, this
terminal may not be recognized normally
even if the terminal is connected while the
application software residents* or is
activated.
Try the following methods in that case.
M To recognize after finishing the running
application
a Remove this terminal from the PC
b Finish CD/DVD playback and the
executants of written application
software
¢ Connect this terminal to the PC

M To recognize via & icon
@For Windows 7
. @ (Start) » Double click @ icon of
"Computer".
@ For Windows Vista
+ @ (Start) » Double click @ icon of
"Computer”.
@ For Windows XP
« [start] » Double click & icon of "My
computer”.
% Including the case in which its icon stays
on the taskbar.
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H Communication problems

Symptom

Check

Communications | Verify if signals are received in the service

are not possible

area.

Check if you set the UIM setting to "Unlock
PINT". =P57

If itis set to "Lock PIN1", launch the L-O3F
Connection Manager, then enter PIN1 code.
—P58

Check the setting of this terminal and the
APN registration.

When connecting manually by L-O3F is not
available, open the property of dial-up
connection and make sure that only
"docomo LO3F Modem Driver" has check
mark in "Connect using".

(If the modem inside PC or other modems
have check marks, packet connection may
be incorrect.)

Even if Auto connection setting is set to
"ON'", auto connection may not be available
depending on the PC or network. In that
case, remove this terminal and insert it into
the PC again.

When using Internet by this terminal, make
sure that wired/wireless LAN or other
communication devices are disconnected.
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M Problems with AT Commands

Symptom

"ERROR"
appears when
AT command is
entered

"OK" does not
appear after an
AT command is
entered

Check
Verify if you entered a correct AT command.

Check the properties of the terminal
software to see whether a device other than
this terminal is selected.

Check the L-O3F Communication
Configuration Files (Drivers) have been
installed and functioned properly.

Verify if the commands start with "AT" or "at".

M Zero installation fails

Symptom

New hardware
detection
screen
appears

Check

If the L-O3F setup screen does not appear,
and the input of driver is required, cancel it
temporarily. Remove this terminal from the
USB port of PC and insert again.

Do not start zero installation during OS
activation. It may take several minutes
depending on the PC. Make sure to start the
installation after the PC runs normally.



M Other problems

Symptom

The terminal
suddenly
stopped working

This terminal is
not detected if it
isinsertedintoa
USB port of PC
after installing
the L-O3F
Communication
Configuration
Files (Drivers)

Internet
connection
speed
decreased
significantly

Check

Verify that the UIM is properly inserted to
this terminal.—=P15

Your PC operating environments may have
changed because a new peripheral or
software was installed. Make a confirmation
with your manufacturer of accessory or
software.

Please confirm the following.

» Whether the PC or OS you are using is in
the latest condition?

(If required, apply revision program of OS
provided from manufacturer.)

Whether this terminal recognizes normally
when other USB devices are inserted into
the USB port of PC?

Whether this terminal operates normally
when being inserted into another PC?
Whether this terminal operates normally
when PC is reset to its default?

*For inquiries related to OS or PC, contact
Microsoft or PC manufactures.

If this terminal is connected to a PC directly,
use the supplied "USB extension cable
(Sample)" to keep away from PC.

Speed may turn slow in unsteady areas such
as LTE/W-CDMA/HSDPA/HSUPA/GPRS
service environment. Move it to another
place and connect again.
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Error Messages

Error Messages
Out of service area

Failed to connect. Do you want to try
again?

Failed to reset L-O3F.

Settings cannot be changed while
connected. Please disconnect to change
the settings.

The confirmed PIN1 code doesn't match
the changed PINT code. Please input
again.

Please check whether the DOCOMO UIM
card is inserted properly.

L-O3F is not recognized

Failed to input PIN1 code for three times.
Please input PIN unlock code.

Incorrect PIN1 code entered. Please try
again. (Retry O/3)

PIN1 code is 4~8 characters.
Please lock PINT code.

Incorrect PINT unlock code entered.
Please try again. (Retry O/10)

L-O3F is locked because the user failed to
input the correct PIN unlocking code 10
times. Please contact DOCOMO service
center.
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Description
You are out of service area or available network.

A network error may occur if you are out of service area or available network area. Make
network setting again.

This terminal failed in resetting. Check if this terminal is inserted correctly in PC and if
it is recognized by PC.

You cannot customize setting during data communication. Set again after closing data
communication.

Two of new PINT code are not identical each other. New PIN1 code you want to change
is not matched to the PIN1 code you entered for verification purpose. Enter correct PIN 1
code.

Make sure to insert UIM into this terminal before inserting to a PC.

Do not remove this terminal from the PC while using. If this terminal cannot be correctly
detected, try to reboot the PC as a remedy.

An incorrect PIN1 code was improperly entered 3 times in a row. Available functions will
be limited. Enter unblocking PIN code to unlock.

An incorrect PINT code has been entered. Enter the correct PINT code again.

Valid PIN1 code is 4- to 8-digit number.
To change the PIN1 code, PINT must be locked. Switch PIN1 unblocking to PIN1 blocking.

An incorrect unblocking PIN code was entered. Please enter the correct unblocking PIN
code.

You are no longer able to use UIM that unblocking PIN code has been improperly entered
10 times in a row. Please contact docomo Shop.



Warranty and After-Sales
Service

ey

« A written warranty is provided with every terminal. Make sure
that you receive it. Store the warranty in a safe place after you
read it and verified that it contains the "Shop name/date" you
purchased the product. If the written warranty does not contain
the necessary information, contact the Shop where you
purchased the product. The warranty is valid for a period of one
year from the date of purchase.

« This product and all accessories are subject to change, in part
or whaole, for the sake of improvement without prior notice.

After-Sales Service

If Problems Occur

« Before requesting service, read the "Troubleshooting"
section in this manual. If the problem still persists,
contact one of the numbers listed in "Repairs" (Japanese
only) on the back of this manual.

For Inquiries Result or When Repair is Required

« Take this terminal to a service center designated by
DOCOMO. Be sure to check the operating hours of the
service center. You must present the warranty.

Please note that depending on malfunctions, it may take
more than a day to repair.

M In the warranty period

« This terminal will be repaired at no charge subject to the
conditions of the warranty.

« The warranty must be presented to receive warranty
service. The subscriber will be charged for the repair of
items not covered in the warranty or repairs of defects
resulting from misuse, accident or neglect even during the
warranty period.

« The subscriber is charged even during the warranty period
for the repair of failures caused by the use of devices or
consumable items that are not DOCOMO specified.

M Repairs may not be possible in the following cases

« When DOCOMO Repairs judges that this terminal is
exposed to water. (Ex: the sticker is reacted to water)

« Repair is not possible when corrosion due exposure to
moisture, condensation or perspiration is detected in a
moisture seal reaction or test, or if any of the internal
boards are damaged or deformed.

¥ Since these conditions are outside the scope of the

warranty, any repairs, if at all possible, will be
charged.

M After expiration of the warranty
All repairs that are requested are charged.
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M Replacement parts

Basically, replacement parts (parts required to maintain
product function) will be kept in stock for at least 4 years
after termination of production. Please note that the
product may not be repaired even during this period,
depending on the malfunctioning parts due to a shortage
of those parts. Depending on the nature of the required
repairs, it may still be possible to repair your terminal
even after this period. Contact "Repairs" (Japanese only)
listed on the back of this manual.

Pay attention

« Do not modify this terminal or its accessories.

- Fire, injury or damage may result.

- If this terminal is modified (part replacement, modification,
painting, etc.), it will be repaired only after the modified parts
have been restored to the condition at the time of purchase.
However, repair may be refused depending on the nature of
madification.

Things like following cases will be regarded as modification of

this terminal.

- Using sticker to decorate this terminal

- Exchanging the packing with those other than DOCOMO
product

- Repair of failures or damage caused by modification are
charged even during the warranty period.

Do not remove any inscription stickers attached to this
terminal. The inscription stickers certify that this terminal
satisfies specific technical standards. If stickers are removed
intentionally or are reattached in such a way that confirmation
of the sticker's contents is impossible, repair or servicing may
be refused because confirmation of whether or not the device
conforms to relevant technical standards cannot be made.
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- Information of settings for each function may possibly be
cleared (reset) due to the malfunction, repair or other
treatment of this terminal.

« Take this terminal to the service center when the inner of this
terminal is exposed to water or moisture. However, repairs may
not be available for some conditions depending on this
terminal.

Updating Software

Download the modification file of this terminal from
download site on the Internet and then update the
software. If software update is necessary, you will be
informed at the NTT DOCOMO website with "S5t
(Information)".

Connect to a PC

The following screen appears if the latest software to be
downloaded.

W When Check latest SW setting (—P860) is set to
"OFF"
« Connect this terminal to the PC » Click &) on the title
bar »



2 Click [Yes]

- Update software following the onscreen instructions from B . R
here. For details, refer to Software Update procedure on Maln SDeCIflcatlonS
the NTT DOCOMO website.

Note

M Operating system
Windows XP Japanese/English version (Service Pack 3)
Windows Vista 32bit/64bit Japanese/English version
(Service Pack 2)
Windows 7 32bit/64bit Japanese/English version
(Service Pack 1)
Mac OS X 10.6.8 32bit/64bit Japanese/English version
Mac 0S X 10.7.2 32bit/64bit Japanese/English version

« Do not unplug this terminal with the computer during
software update.

Software update (downloading and rewriting) may take a
while.

If software update fails, all operations become unavailable.
In this case, bring this terminal to a DOCOMO service
center.
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Il Communication Speed
Up to 75Mbps for receiving data
Up to 25Mbps for sending data
% Communication speed is theoretical value when sending

and receiving data which does not show the actual ones.

The actual communication speed depends on
communication environment and network congestion.

% Depending on the bandwidth of Xi area, the theoretical
value is 100/100/75/37.5Mbps for receiving speed
(bandwidth [20/15/10/5MHz]) and 50/37.5/25/
12.5Mbps for sending speed (bandwidth [20/15/10/
5MHz)

% Refer to NTT DOCOMO website for detailed areas that
support Xi.

% Receiving data up to 14Mbps, sending data up to
5.7Mbps in FOMA HIGH-SPEED area out of Xi area.

% Sending and receiving data speed may become up to
384kbps in the FOMA HIGH-SPEED area.

% Sending and receiving data speed becomes up to
384kbps in FOMA area out of Xi area and FOMA HIGH-
SPEED area.

M Operating environments
Temperature : 5C to 35T
Humidity : 45% to 85%
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W Power source
Power voltage
DCBV (Supplied from PC)
Max Current consumption™
Max Current consumption while communicating
LTE: Approx. xxxmA or lower
3G: Approx. xxxmA or lower
GPRS: Approx. xxxmA or lower
Average Current consumption while communicating
LTE: Approx. xxxmA or lower
3G: Approx. xxxmA or lower
GPRS: Approx. xxxmA or lower
Average Current consumption while Standby:
LTE: Approx. xxxmA or lower
3G: Approx. xxxmA or lower
GPRS: Approx. xxxmA or lower
¥ Depending on the usage, power consumption fluctuates.
M Form factor
USB connection type
Ml Dimensions
Height: Approx. xxmm
Width: Approx. xxmm
Depth: Approx. xxmm
H Weight
ApPpProx. Xxxg

B JATE certification number
AD11-0386001



Export Administration
Regulations

This product and its accessories are under coverage of the
Export Administration Regulations of Japan ("Foreign
Exchange and Foreign Trade Control Laws" and the related
laws and regulations). When exporting this product and its
accessories, take necessary procedures on your
responsibility and expense. For details, contact Ministry of
Economy, Trade and Industry.

Declaration of Conformity

The product "L-O3F" is declared to conform with the
essential requirements of European Union Directive 1999/
5/EC Radio and Telecommunications Terminal Equipment
Directive 3.1(a), 3.1(b) and 3.2.
This wireless portable device complies with the EU
requirements for exposure to radio waves.
Your wireless portable device is a radio transceiver and
receiver. It is designed not to exceed the SAR* (Specific
Absorption Rate) limits** for exposure to radiofrequency
(RF) energy by European Union Directives. The Max. SAR*
value is 0.640W/kg (10 g) when it is worn on the body. To
comply with the RF Exposure limits a distance of greater
than 1.5 cm must be maintained from the user's body.
While there may be differences between the SAR* levels of
various wireless portable devices and at various positions,
they all meet*** the EU requirements for RF exposure.
* The exposure standard for wireless portable devices
employs a unit of measurement known as the Specific
Absorption Rate, or SAR.

** The SAR limit recommended by the International
Commission on Non-lonizing Radiation Protection (ICNIRP)
is 2W/kg averaged over 10g of tissue.

***Tests for SAR have been conducted using standard
operating positions with the transmitting at its highest
certified power level in all tested frequency bands. Although
the SAR is determined at the highest certified power level,
the actual SAR level of the wireless portable device while
operating can be well below the maximum value. This is
because the wireless portable device is designed to operate
at multiple power levels so as to use only the power required
to reach the network.

In general, the closer you are to a base station antenna, the
lower the power output.

European Union Directives Conformance

Statement

product is in compliance with:

«The essential requirements and other relevant
provisions of Directive 1999/5/EC

«All other relevant EU Directives

c € Hereby, LG Electronics, Inc. declares that this

The above gives an example of a
c E 0 168 typical Product Approval Number.
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FCC Regulations

Statement

This equipment has been tested and found to comply with
the limits for a class B digital device, pursuant to Part 15
of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a
residential installation. This equipment generates uses and
can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause
harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful
interference or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or
more of the following measures:

- Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for
help.

Change or Modifications that are not expressly approved
by the manufacturer could void the user's authority to
operate the equipment.
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Class B Compliance

This device and its accessories comply with part15 of FCC

rules.

Operation is subject to the following two conditions:

« This device & its accessories may not cause harmful
interference.

« This device & its accessories must accept any interference
received, including interference that may cause undesired
operation.

Normal Operation

This device has been tested in normal operating positions
as defined in the Manual at a distance of 0.19inches (0.5cm)
from the user's body.

To comply with FCC RF exposure requirements, a minimum
separation distance of 0.19inches (0.5cm) must be
maintained from the user's body.

Consumer Information on SAR (Specific Absorption
Rate)

THIS DEVICE MEETS THE GOVERNMENT'S
REQUIREMENTS FOR EXPOSURE TO RADIO WAVES.
Your wireless device is a radio transmitter and receiver. It
is designed and manufactured not to exceed the emission
limits for exposure to radio frequency (RF) energy set by
the Federal Communications Commission of the U.S.
Government. These limits are part of comprehensive
guidelines and establish permitted levels of RF energy for
the general population. The guidelines are based on
standards that were developed by independent scientific
organizations through periodic and thorough evaluation of
scientific studies.



The standards include a substantial safety margin
designed to assure the safety of all persons, regardless of
age and health. The exposure standard for wireless
devices employs a unit of measurement known as the
Specific Absorption Rate, or SAR.

The SAR limit set by the FCC is 1.6W/kg.

% Tests for SAR are conducted using standard operating
positions specified by the FCC with the device
transmitting at its highest certified power level, the actual
SAR level of the device while operating can be well below
the maximum value. This is because the device is
designed to operate at multiple power levels so as to use
only the power required to reach the network. In general,
the closer you are to a wireless base station antenna, the
lower the power output.

Before a device is available for sale to the public, it must be
tested and certified to the FCC that it does not exceed the
limit established by the government-adopted requirement
for safe exposure. The tests are performed in positions and
locations as required by the FCC for each model.

The FCC has granted an Equipment Authorization for this
device with all reported SAR levels evaluated as in
compliance with the FCC RF emission guidelines. SAR
information on this device is on file with the FCC and can
be found under the Display Gant section of http://
www.fcc.gov/oet/ea/fccid/ after searching on FCC ID
ZNFLO3F. Additional information about Specific Absorption
Rates (SAR) can be found on the Cellular
Telecommunications Industry Association (CTIA) website
at http://www.ctia.org/.

Intellectual Property Rights

Copyrights and Rights of Portrait

Without permission of the copyright owner you may not
duplicate, modify, transmit over public communication
lines, etc. any document, image, music, software, or other
content owned by a third party that you have used this
product to download from an Internet website, etc., except
for private uses such as duplication and indexing that are
allowed by copyright law.

« "FOMA""i-mode" "i-appli" "mopera U" "WORLD WING" "Xi"and "Xi"
logo are trademarks or registered trademarks of NTT
DOCOMO, INC.

Microsoft®, Windows®, Windows Vista® are trademarks or

registered trademarks of Microsoft Corporation in United

States and/or other countries.

In this manual, each OS (Japanese version) is described in the

following short form.

- Windows 7 is short for Microsoft® Windows® 7(Starter, Home
Basic, Home Premium, Professional, Enterprise, Ultimate).

- Windows Vista is short for Windows Vista®(Home Basic,
Home Premium, Business, Enterprise, Ultimate).

- Windows XP is short for Microsoft® Windows® XP
Professional operating system or Microsoft® Windows® XP
Home Edition operating system.

« OS may be written abbreviated such as Windows 7, Vista, XP.

.
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- Apple, Apple logo, Mac, Mac 0OS, Macintosh are registered
trademark of Apple Inc. of US and other countries.

- Adobe, Adobe Flash Player and Adobe Reader are either
registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

« Other company names or product names mentioned in this
work are the trademarks or registered trademarks of their
respective owners.
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Back Cover..................... 14
CE ... 121
Communication Speed......... 120
Communication Status Lamp . . . .. 14
Configuring Dial-up Network Manually

For Windows.................. 73
Configuring Network . .. .......... 92
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L
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You can register a confirmation/change of contracts, or request information material at the DOCOMO online.
FromaPC My docomo (http://www.mydocomo.com/) = SEHEHA - BF#HE (Subscriptions/Procedures) (Japanese only)
% "docomo ID/Password" is required if you access the site from a PC.

% If you do not have or remember the "docomo ID/Password’, contact the "docomo Information Center" listed on the back of this manual.
% Some contracts may not be available for using.
¥ You may not be able to use online service due to system maintenance, etc.

Don't forget your terminal--- or your manners!
When using this terminal, be considerate and do not disturb people around you.

OThe following cases, be certain to turn off your PC in which this terminal is inserted.

W Where use is prohibited
There are some places which this terminal can not be used. Be sure to turn off your PC in which this terminal is inserted.
¥ Persons with electronic medical equipment are in places other than the actual wards. Make sure you have the power
switched off even if you are in a lobby or waiting room.
W While driving
Using this terminal interferes with safe driving and may be dangerous.

W When in crowded places such as packed trains, where you could be near a person with an implanted cardiac
pacemaker or implanted defibrillator

The implanted cardiac pacemaker or implanted defibrillator operation can be adversely affected.
Hl When in theaters, movie theaters, museums, and similar venues
If you use this terminal where you are supposed to be quiet, you may disturb those around you.

l We collect old phones, etc. regardless of brands and manufacturers. Bring them to your nearest docomo Shop.
~ ¥ ltems to be collected: mobile phones, PHS, battery packs, chargers, desktop holders (regardless of brands
and manufacturers)
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General Inquiries
<docomo Information Center>

(Business hours: 9:00 a.m. to 8:00 p.m.)
8. 0120-005-250 (toll free)

* Service available in: English, Portuguese, Chinese, Spanish, Korean.
* Unavailable from part of IP phones.

(Business hours: 9:00 a.m. to 8:00 p.m. (open all year round))
WFrom DOCOMO mobile phones WFrom land-line phones
(In Japanese only) (In Japanese only)

ﬂ (No prefix) 151 (toll free) 18 0120-800-000 (toll free)
* Unavailable from land-line phones, etc. * Unavailable from part of IP phones.
@Please confirm the phone number before you dial.

(Business hours: 24 hours. (open all year round))

WFrom DOCOMO mobile phones

WFrom land-line phones
(In Japanese only)

(In Japanese only)

ﬂ (No prefix) 1 1 3(toll free) 8 0120-800-000 (toll free)

* Unavailable from land-line phones, etc. * Unavailable from part of IP phones.

@For Applications or Repairs and After-Sales Service, please contact the above-mentioned information center or the docomo shop etc. near you on the NTT DOCOMO website.

NTT DOCOMO website http://www.nttdocomo.co.jp/english/

Loss or theft of this terminal or payment of

cumulative cost overseas
<docomo Information Center> (available 24 hours a day)
From DOCOMO maobile phones

International call access code for
-81-3-6832-6600* (toll free)

*You are charged a call fee to Japan when calling from a land-line phone, etc.

From land-line phones
<Universal number>
International prefix number for "
the universal number -8000120-0151
* You might be charged a domestic call fee according to the call rate for the country you stay.

s%For international call access codes for major countries and universal number international
prefix, refer to DOCOMO International Services website.

Failures encountered overseas

<Network Support and Operation Center> (available 24 hours a day)

From DOCOMO mobile phones

International call access code for
-81-3-6718-1414*toll free)

* You are charged a call fee to Japan when calling from a land-line phone, etc.

From land-line phones
<Universal number>
International prefix number for ¥
the universal number -8005931-8600
* You might be charged a domestic call fee according to the call rate for the country you stay.

3For international call access codes for major countries and universal number international
prefix, refer to DOCOMO International Services website.

@If you lose your terminal or have it stolen, immediately take the steps necessary for suspending the use of this terminal.
@If your terminal is damaged, bring your terminal to a repair counter specified by DOCOMO after returning to Japan.

Don't forget your mobile phone -+ or your manners!
O When using your mobile phone in a public place, don't forget to show common courtesy and consideration for others around you.

Sales: NTT DOCOMO, INC.
Manufacturer: LG Electronics Inc.

'14.x (1.0 Edition)
MFLXXXXXXXX



	Cover
	Before Using this Terminal
	SIM unlock
	Basic Package
	How to Read this Manual
	Contents
	Features of the L-03F
	Safety Precautions (ALWAYS FOLLOW THESE PRECAUTIONS)
	Handling and Care

	Before Using this Terminal
	Names of Parts and Functions
	Using UIM
	Available Communications
	Connecting this Terminal to a PC

	Setting Up
	Setting Up
	Windows Version
	Mac Version

	L-03F Connection Manager
	L-03F Connection Manager
	Using Packet Communication
	Settings

	Mobile Broadband
	Mobile Broadband
	Connecting through Mobile Broadband
	Disconnecting Mobile Broadband
	Changing APN Settings
	Setting UIM

	Configuring Network Manually
	Windows Version

	Overseas Use
	International Roaming Service (WORLD WING)
	Services Available Overseas
	Before Using Overseas
	Setting the Searching Method for Available Networks
	Configuring Network

	Appendix/Troubleshooting
	AT Commands
	AT Command List
	Options and related devices
	Troubleshooting
	Error Messages
	Warranty and After-Sales Service
	Updating Software
	Main Specifications
	Export Administration Regulations
	Intellectual Property Rights
	Index

	Don't forget your terminal… or your manners!
	Cover



